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This file contains the main "Welcome" topics for Simply3D 3 help. Note that the Office Compatible topic is called 
from a separate help file, per Microsoft requirement.
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This is version 06/11/98 4:18 PM of help for Simply3D 3 full, English.



Welcome to Micrografx Simply3D

Thank you for buying Micrografx® Simply3D  Version 3.
We have designed Simply3D to make it easy for you to create your own still or animated 3D scenes. You can use 
supplied 3D objects, create your own 3D text, or create new objects from any of 10 basic 3D shapes.
Your scenes can be used with many Windows 95 and Windows NT programs, including Microsoft Word for 
Windows, Microsoft PowerPoint, and Micrografx products such as Windows Draw, Picture Publisher, Micrografx 
Designer, and ABC FlowCharter.
We hope you'll enjoy using Simply3D, and thanks again from everyone at Micrografx.
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Simply3D Features

Simply3D combines three-dimensional rendering, animation, and modeling into one easy-to-use program. 
Features include:
· Animated objects, lights, and materials.
· Wizards to help you create scenes from scratch, create 3D animated text, and even output your finished 

scene to paper, a Web site, or another program.
· A built-in catalog with professionally designed resources that you can drag into your scenes. Resources 

include three-dimensional objects, materials, lighting schemes, and pre-built animations and deformations.
· A Scene Explorer that lists the resources in your scene by the names you give them. You can change the 

hierarchy of items by simply dragging them.
· Animation formats, including AVI, FLC, Animated GIF and VRML (Virtual Reality Modeling Language) files.
· Motion paths that you can move, scale, rotate, and reshape, and animation timing bars that you can drag to 

choreograph your animations.
· 3D primitive shapes that you can either use “as is” or reshape to create new objects of your own design.
· 2D-object extrusion, which lets you add depth to two-dimensional drawings.
· Built-in object-reshaping tools that let you bend, twist, flatten, and otherwise reshape objects, including 3D 

text objects.
· Flexible display options, including wireframe, solid shaded, and texture mapped views¾all in real time.
· Built-in support for OpenGL® and Direct3D acceleration.
· Realistic reflections and refraction effects made possible by ray-tracing.

{button Related Topics,PI(`',`RT_Simply_3D_Features')}
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What's New in Version 3?

 Ease-of-Use Features
· As you pass the mouse pointer across an animation in the catalog, the icon becomes animated to show how 

the animation will look.
· When you resize or maximize a scene's window, Simply3D 3 automatically maintains the scene's height-to-

width ratio.
· Wizards take you step-by-step through many scene-building tasks.
· You can align objects according to their bounding boxes. This makes it much easier, for example, to place an 

object on a table without intersecting the table.
· The properties of each material are now controllable through the Material editor rather than the Object 

Properties dialog box.
· You can now undo changes you have made to a material after closing the Material editor.

 2D-to-3D Features
· 2D-object extrusion lets you add depth and beveled edges to two-dimensional shapes that you import or 

copy from drawing programs. 
· You can apply different materials to the front, bevel, and side edges. This also works with 3D text.

 Object and 3D Text Features
· You can apply animated reshaping (morphing) to an object.
· You can hide any object in your scene. Hiding complex objects can speed previewing and rendering.
· You can control an object's rotations by repositioning its pivot point. (Scaling still uses the object's geometric 

center.)
· You can choose to reshape objects in-place (while working in the Camera, Top, Side, and Front views). You still

have the option of using each tool's specialized windows for reshaping, as in earlier versions.
· The reshaping tools work in unison, letting you apply several types of reshaping to an object. Simply3D 3 

tracks all reshaping actions by building a reshape list, which you can edit.
· Animation paths and text paths can now be reshaped.

 Material Features
· You can position and scale an object's materials, either by using the Move and Scale tools in the Camera, Top,

Side, and Front views, or by using the Material editor.
· Animate the surface of an object by applying animated materials from the catalog or by dragging an AVI 

video clip from the Windows Explorer.
 Lighting Features

· You can now animate lights. You can even make a light move with one object while it remains aimed at 
another moving object.

· You can turn off any light in your scene to speed rendering or to try several lighting variations without 
deleting lights.

{button Related Topics,PI(`',`RT_What_s_New_in_Version_3')}
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Getting Assistance as You Work

Besides the information you get automatically through ToolTips and the Status bar, you can request additional 
help.
 

Help for Menu Items and Toolbar Buttons

To see information about a specific menu item or toolbar button, click the Help button  on the Standard 
toolbar. The mouse pointer changes to a "?" symbol. Click the menu item or button for which you want help. A 
popup message appears.

To close the popup message, press the ESC key.

Help for a Dialog box
Simply3D dialog boxes have a Help button. For information on how to use the various controls of a dialog box, 
click the Help button. A popup message tells you how to use the tool or button. 
To close the popup message, press the ESC key.

Help from the Help Menu
For more detailed help, click Simply3D Help on the Help menu. You can find the topic you need by using the Help
table of contents, the Help Index, or by using the Find feature to quickly search the entire Help file for a specific 
word or phrase.
Numbered steps for Simply3D procedures are shown in a Steps window. It appears on the right-hand side of the 
screen and stays in front of other windows so you can perform each step without Simply3D's window covering up
the remaining steps.
· To close any active Help window, press the ESC key.

{button Related Topics,PI(`',`RT_Getting_Assistance_As_You_Work')}
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This document contains the animation topics for Simply3D help.



Animating Lights
{button Tell me how...,PI(`',`HT_Animating_Lights')}

You can create scenes with animated lights in Simply3D 3:
· By adding an animated lighting scheme from the catalog.
· By applying a catalog animation to a light.
· By locking a spotlight's beam on an animated target object.
· By attaching a light to an animated object.

{button Related Topics,PI(`',`RT_Animating_Lights')}



To select a light 
To add animated lights from the catalog 
To apply a catalog animation to a light 
To aim a light at a target object 
To attach a light to an object 
To change a light's type 



Adding and Removing Lights 
Moving and Aiming Lights 
Animating Multiple Objects 
Shaping an Animation Path 



To add animated lights from the catalog

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 Click the Lights tab to display thumbnails of the available lighting schemes.
3 Click the small tab labeled Animated.
4 Double-click the animated lighting scheme that you want.
Tip
· You can see a sample of an animation in the catalog by pausing the pointer on the animation's thumbnail.

{button Related Topics,PI(`',`RT_To_add_animated_lights_from_the_catalog')}
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To apply a catalog animation to a light

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 Cick the Animations tab to display icons of the available animations.
3 Drag the animation you want, and drop it in the Scene Explorer on the light to be animated. The animation's 

path is highlighted in the project window.
Tips
· You can see a sample of an animation in the catalog by pausing the pointer on the animation's thumbnail.
· You can create complex animations for a light by attaching the light to a transparent object, creating a parent

for the object, and applying different animations to the object and its parent.

{button Related Topics,PI(`',`RT_To_animate_an_object_using_a_catalog_animation')}



To preview the animations in a scene 
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To animate an object using a catalog animation

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 Cick the Animations tab to display icons of the available animations.
3 Drag the animation you want, and drop it on the object to be animated. The animation's path is highlighted in

the project window.
Tips
· You can see a sample of an animation in the catalog by pausing the pointer on the animation's thumbnail.
· If the target object is surrounded by other objects, drop the animation on the object's name in the Scene 

Explorer.

{button Related Topics,PI(`',`RT_To_animate_an_object_using_a_catalog_animation')}
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To animate an object using a wizard

 
1 In the Scene Explorer, right-click the object. A shortcut menu appears.
2 Click Select Animation.
3 Click the specific animation you want.
Tips
· You can see a sample of an animation by pausing the pointer on the animation's thumbnail.
· Use the camera preview area to see you how your results will look. This area also has tools to let you move 

the camera, render the scene, and play animations contained in the scene.
· When you click or drag in four-up view, Simply3D displays a yellow border around the active view. This is 

particularly helpful for previewing animations, because only the active view shows the animation.

{button Related Topics,PI(`',`RT_To_animate_an_object_using_a_shortcut_menu')}
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To animate existing text
1 In the Scene Explorer, click the text object.

2 If you don't see the catalog at the bottom of the project window, click the Show/Hide Catalog button  on 
the Standard toolbar.

3 In the catalog, click the Animations tab.
4 Find the animation that you want to apply to the text, and double-click it.
5 On the Animation Control toolbar, click the Play button  to preview the animation.

{button Related Topics,PI(`',`RT_To_animate_text_using_the_Text_tool')}



To apply different animations to the letters of a text object
To animate an object using a catalog animation 
To animate an object using a wizard 
To apply an animated deformation to an object 
To preview the animations in a scene 
To remove an animation 
To rename an animation 

Animating Multiple Objects 
Animating Lights 
Previewing Animations 
Morphing an Object (Animated Reshaping) 



Animating Multiple Objects
{button Tell me how...,PI(`',`HT_Animating_Multiple_Objects')}

The nature of a parent-child relationship allows you to create complex animations. Because changes to the 
parent affect all the children but changes to the children do not affect the parent, you can:
· Animate a group of objects as a single object.
· Animate the members of a group separately.
· Use grouping to apply multiple animations to an object.

Objects animated as a group and separately Three animations affecting one object

{button Related Topics,PI(`',`RT_Animating_Multiple_Objects')}
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To animate grouped objects together
1 In the Scene Explorer, right-click the parent of the group. A shortcut menu appears.
2 Click Select Animation.
3 Click the specific animation you want.
Tips
· You can see a sample of an animation by pausing the pointer on the animation's thumbnail.
· This method works for separated letters of a 3D text object, provided you apply the animation to the parent 

text object.
· When you click or drag in four-up view, Simply3D displays a yellow border around the active view. This is 

particularly helpful for previewing animations, because only the active view shows the animation.

{button Related Topics,PI(`',`RT_To_animate_grouped_objects_together')}
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To animate grouped objects separately
1 In the Scene Explorer, click one of the grouped objects¾not the parent of the group.
2 In the catalog, locate the animation you want to apply to the object, and double-click it.
3 Repeat steps 1 and 2 for each of the remaining objects.
Tip
· You can see a sample of an animation by pausing the pointer on the animation's thumbnail in the catalog.
· You can separate the letters of a 3D text object to animate them as individual objects.

{button Related Topics,PI(`',`RT_To_animate_grouped_objects_separately')}
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To apply different animations to the letters of a text object
1 In the Scene Explorer, right-click the text object. The object's shortcut menu appears.
2 Click Separate Letters. Each letter is changed to a child object, with the original text object as the parent.
3 Drag animations from the catalog, and drop them on the separate lettters.
Tip
· You can see a sample of an animation by pausing the pointer on the animation's thumbnail in the catalog.

{button Related Topics,PI(`',`RT_To_animate_text_letters_separately')}
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To apply multiple animations to the same object
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Click Create Parent. A new, parent object appears one level up from the original object.
3 Click the parent object.
4 In the catalog, either double-click the animation that you want or drag it from the catalog to the parent.
5 Click the original object (now a child object).
6 Repeat step 4 to apply a second animation, but apply it to the original object.
Tips
· You can use the Animation Editor to adjust the timing of the two animations separately.
· You can use this method to stack more than two animations per object. Just add a parent for each animation 

that you want to add.

{button Related Topics,PI(`',`RT_To_apply_multiple_animations_to_the_same_object')}
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To apply an edited animation to other objects
In the Scene Explorer, drag the edited animation and drop it on each of the other objects.

Tip
· Consider grouping the objects. If you assign a rotation to multiple selected objects, each object rotates 

around its own pivot point. If you group them and then assign the rotation to their parent object, all the 
objects rotate around the parent's pivot point.

{button Related Topics,PI(`',`RT_To_apply_the_same_animation_to_multiple_objects')}



To animate grouped objects together 
To animate grouped objects separately 
To apply multiple animations to the same object 
To animate existing text 
To preview the animations in a scene 

Animating Multiple Objects 



Previewing Animations
{button Tell me how...,PI(`',`HT_Previewing_Animations')}

Simply3D animates your scene (simulates motion) by rapidly displaying a sequence of snapshots called frames. 
Each frame depicts your scene as it would appear at a specific moment in time. Simply3D creates the frames as 
you assign animations to objects.
Simply3D lets you preview your animations, in wireframe or shaded view, using a VCR-like Animation Control 
toolbar.

Animation Control Toolbar

 
By previewing individual frames of your animation, you can see the relationship of an object to the camera and 
other objects at any point in time. You can render any animation frame as a still image and save it as an image 
file (for example, BMP or GIF).
You can save an animated scene as an AVI, animated GIF, or animated VRML 2.0 file.
Notes
· The buttons on the Animation Control toolbar are disabled (dimmed) until you add at least one animation to 

your scene.
· When you click or drag in four-up view, Simply3D displays a yellow border around the active view. This is 

particularly helpful for previewing animations, because only the active view shows the animation.

{button Related Topics,PI(`',`RT_Previewing_Animations')}
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To preview the animations in a scene

 
On the Animation Control toolbar, click the Play button 

.
Tip
· When you click or drag in four-up view, Simply3D displays a yellow border around the active view. This is 

particularly helpful for previewing animations, because only the active view shows the animation.
Notes
· If the Animation Control toolbar is not displayed, open the View menu, click Toolbars, and then click to select 

the toolbar.
· The buttons on the Animation Control toolbar are disabled (dimmed) until you add at least one animation.

{button Related Topics,PI(`',`RT_To_preview_the_animations_in_a_scene')}
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To step frame-by-frame through animations

 
On the Animation Control toolbar, click the Previous Frame 

 or the Next Frame 
 button. The frame counter is updated as you step.

Tip
· When you click or drag in four-up view, Simply3D displays a yellow border around the active view. This is 

particularly helpful for previewing animations, because only the active view shows the animation.
Note
· If the Animation Control toolbar is not displayed, open the View menu, click Toolbars, and then click to select 

the toolbar.

{button Related Topics,PI(`',`RT_To_step_frame_by_frame_through_animations')}



To preview the animations in a scene 
To jump to a scene's first or last animation frame 
To jump to a specific animation frame 

Animating Lights 
Previewing Animations 



To jump to a scene's first or last animation frame

 
On the Animation Control toolbar, click the Rewind button 

 or the Skip to End button 
.

Note
· If the Animation Control toolbar is not displayed, open the View menu, click Toolbars, and then click to select 

the toolbar.

{button Related Topics,PI(`',`RT_To_jump_to_a_scene_s_first_or_last_animation_frame')}
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To jump to a specific animation frame

 
On the Animation Control toolbar, double-click the Frame Number box 

, type the frame number, and then press ENTER.
Note
· If the Animation Control toolbar is not displayed, open the View menu, click Toolbars, and then click to select 

the toolbar.

{button Related Topics,PI(`',`RT_To_jump_to_a_specific_animation_frame')}
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To reverse the direction of an animation

1 If the Animation Editor is not displayed, click the Show/Hide Animation Editor button  on the Standard 
toolbar. The Animation Editor appears.

2 Click the "+" symbols as necessary to show the animation bar for the object or light you want to change.
3 Click the animation bar for the object's or light's path.

4 On the Animation editor's toolbar, click the Reverse Animation  button.

{button Related Topics,PI(`',`RT_To_reverse_the_direction_of_an_animation')}
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To speed up or slow down an animation

1 If the Animation Editor is not displayed, click the Show/Hide Animation Editor button  on the Standard 
toolbar. The Animation Editor appears.

2 Click the "+" symbols to show the animation bar for the object you want to change.
3 On the object's or light's animation bar, drag the start point and the end point as necessary to shorten or 

lengthen the animation's duration. Lengthen the duration to slow the animation; shorten it to speed up the 
animation.

Note
· Although you cannot drag an end point past the scene's last animation frame, you can add empty frames to 

the end of the scene. You can then drag an end point into the new frames.

{button Related Topics,PI(`',`RT_To_speed_up_or_slow_down_an_object_s_animation')}
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To adjust the timing of an animation

1 If the Animation Editor is not displayed, click the Animation Editor button  on the Standard toolbar. The 
Animation Editor appears.

2 Click the "+" symbols to show the animation bar for the object you want to change.
3 Drag the object's or light's animation bar to the left to start the animation sooner; drag to the right to start 

the animation later.
Tips
· Although you cannot move an animation's end point past the scene's last animation frame, you can add 

empty frames to the end of the scene. You can then drag the animation bar into the empty frames.
· You can create a pause between two animations by leaving several frames between the end point of one and 

the start point of the other. 

{button Related Topics,PI(`',`RT_To_adjust_an_object_s_animation_forward_or_backward_in_time')}
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To reposition or rotate the path of a move animation
1 In the Scene Explorer, click the animation to select it.

2 In the Toolbox, click either the Move  or the Rotate 
 button, and then click the tool for the type of movement or rotation you want.

3 In any view, drag to move or rotate the path.

{button Related Topics,PI(`',`RT_To_reposition_or_rotate_the_path_of_a_move_animation')}
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To scale the path of a move animation
1 In the Scene Explorer, click the animation to select it.

2 In the Toolbox, click the Scale button , and then click the tool for the axis that you want to scale.
3 In any view, drag to scale the animation path.

{button Related Topics,PI(`',`RT_To_scale_the_path_of_a_move_animation')}



To reposition or rotate the path of a move animation 
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To tilt the axis of a rotate animation
1 In the Scene Explorer, right-click the object, and then click Create Parent. A new, parent object appears one 

level up from the original object.
2 Right-click the animation to display its shortcut menu, and then click Cut. The animation is removed from the 

original object and placed on the Clipboard.
3 Right-click the parent object you have created, and click Paste to apply the animation to the parent object. 

You can now rotate the animation without rotating the original object.

4 In the Toolbox, click the Rotate button , and then click one of the rotation tools.
5 In any view, drag to tilt the axis of the animation.

{button Related Topics,PI(`',`RT_To_tilt_the_axis_of_a_rotate_animation')}
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To add frames to the end of a scene

1 If the Animation Editor is not displayed, click the Animation Editor button  on the Standard toolbar. The 
Animation Editor appears.

2 Right-click anyplace on the right-hand pane, and then click Add/Subtract Scene Animation Frames.
3 In the Scene Animation Frame Count box, type the total number of frames that you want the scene to have.

{button Related Topics,PI(`',`RT_To_extend_the_duration_of_an_animated_scene')}



To remove empty frames from the end of a scene 
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To remove empty frames from the end of a scene

1 On the Standard toolbar, click the Animation Editor button . The Animation Editor appears.
2 Right-click anyplace on the right-hand pane, and then click Add/Subtract Scene Animation Frames.
3 Change the number in the Scene Animation Frame Count box:

· To remove all empty frames, type 0 and press ENTER. Simply3D removes only the empty frames at the 
end.

· To remove some¾but not all¾of the empty frames, subtract from the current frame count the number of 
frames that you want to remove, type the result, and then press ENTER.

Note
· You cannot accidentally remove frames that contain an animation.

{button Related Topics,PI(`',`RT_To_remove_empty_frames_from_the_end_of_an_animated_scene')}



To add frames to the end of a scene 
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To remove an animation
1 In the Scene Explorer, click the animation to select it.
2 Press the DELETE key.
Note
· If necessary, click the "+" next to the object's or light's name to show its animation.

{button Related Topics,PI(`',`RT_To_remove_an_object_s_animation')}
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To rename an animation
1 In the Scene Explorer, click the animation.
2 Pause briefly, and then click the name a second time. A cursor appears, showing that you can now edit the 

name.
3 Type the new name, and then press ENTER.
Note
· If necessary, click the "+" next to the object's or light's name to show its animation.

{button Related Topics,PI(`',`RT_To_rename_an_object_s_animation')}
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This file contains the "Changing the Background" topics for Simply3D help.



 Changing the Background
{button Tell me how...,PI(`',`HT_Changing_the_Background')}

Every Simply3D scene has a background. Unless it is obscured by objects, the background is always in view.
You can change the background color (the default is black), use a catalog material, or use a bitmap or Clipboard 
image as the background.

Custom color as background Bitmap image as background

When you use an image as the backgound for your scene, Simply3D automatically stretches or compresses the 
image to fit the size of your project window. The image may become distorted in the process. If this happens, 
you can change the aspect ratio of your project window or select an image with the same aspect ratio as your 
project window.
Note
· The Background does not receive shadows. If you want the objects in your scene to cast shadows on a flat 

surface, add a wall or floor to receive the shadows.
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To remove the image from the background 



To use a catalog material as the background

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 Click the Materials tab, and use the scroll bar to view the available materials.
3 Drag the thumbnail image of the material that you want, and drop it on the Background icon in the Scene 

Explorer.
Tip
· You can use an animated material as the background.

{button Related Topics,PI(`',`RT_To_set_a_scene_s_background_color')}
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To remove the image from the background 

Changing the Background 



To set a scene's background color
1 In the Scene Explorer, right-click Background, and click Set Color.
2 Either click a color in the palette or click Define Custom Colors.
3 If you are defining a custom color, enter the values for the new color or drag the sliders. Then, click Add to 

Custom Colors
4 Click OK to apply the color to the background.
Note
· If your background consists of an image, the new background color replaces the image.

{button Related Topics,PI(`',`RT_To_set_a_scene_s_background_color')}



To lighten or darken the background color 
To paste a Clipboard image as the background 
To use a catalog material as the background 
To use a bitmap file as the background 
To remove the image from the background 

Changing the Background 



To lighten or darken the background color
1 In the Scene Explorer, right-click Background, and click Set Color.
2 Click Define Custom Colors.
3 Drag the brightness slider up or down to lighten or darken the color. 
4 Click Add to Custom Colors
5 Click OK to apply the color to the background.

{button Related Topics,PI(`',`RT_To_lighten_or_darken_the_background_color')}



To set a scene's background color 
To paste a Clipboard image as the background 
To use a catalog material as the background 
To use a bitmap file as the background 
To remove the image from the background 

Changing the Background 



To paste a Clipboard image as the background
1 In the Scene Explorer, right-click Background, and click Paste.
Note
· Make sure that the program you use to copy the image to the Clipboard places the image there as a bitmap.

{button Related Topics,PI(`',`RT_To_paste_a_Clipboard_image_as_the_background')}



To set a scene's background color 
To lighten or darken the background color 
To use a catalog material as the background 
To use a bitmap file as the background 
To remove the image from the background 

Changing the Background 



To use a bitmap file as the background
1 In the Scene Explorer, right-click Background, and then click Set Image.
2 Navigate to the folder that contains the bitmap file, and double-click the filename. The bitmap image 

becomes the scene's background.
Tips
· You can use any catalog material as a background, including animated materials. Just drag the material and 

drop in on the Background icon in the Scene Explorer.
· You can drag a bitmap file directly from the Windows Explorer and drop in on the Background icon in the 

Scene Explorer.

{button Related Topics,PI(`',`RT_To_use_a_bitmap_file_as_the_background')}



To use a catalog material as the background 
To set a scene's background color 
To lighten or darken the background color 
To paste a Clipboard image as the background 
To remove the image from the background 

Changing the Background 



To remove the image from the background
In the Scene Explorer, right-click Background, and click Clear.

{button Related Topics,PI(`',`RT_To_remove_the_image_from_the_background')}



To use a catalog material as the background 
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Changing the Background 
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Camera.DOC
This document contains the camera-related topics for Simply3D help.



To select the camera using the Scene Explorer
In the Scene Explorer, click View (at the top of the list).

{button Related Topics,PI(`',`RT_To_select_the_camera_using_the_Scene_Explorer')}



Moving the Camera 
Aiming the Camera 
Rotating the Camera 
Setting the Lens Angle 



Moving the Camera
{button Tell me how...,PI(`',`HT_Moving_the_Camera')}

The camera is a valuable tool that can be manipulated to help you achieve an interesting visual perspective. By 
moving the camera, you can change the entire character of a scene.

Default Camera Position Camera Moved to Different View

Working in Top, Side, and/or Front view, you can move the camera up-down, left-right, and in-out around it’s 
aiming point. As you move the camera, it automatically rotates so that it remains aimed at the aiming point. The 
camera's aiming point is represented by a small set of crosshairs.
Using the rotate tools, you can move the camera and maintain a constant distance from the aiming point. 

Camera Moved Around Aiming Point

 
You can also center the camera, which positions it to view all objects in the scene.
Note 
· If you lock the camera's aiming point on a target object, the point remains locked on the target object when 

you move the object manually or move the camera in the Top, Side, or Front view.    However, the camera 
does not follow an animated target object. Also, if you want the aiming point to remain on the target object 
while you are using Camera view, you must use the Rotate tools instead of the Move tools. Note that the 
Rotate tools don't let you change the distance between the camera and its aiming point.

{button Related Topics,PI(`',`RT_Moving_the_Camera')}



To move the camera by dragging 
To move the camera to specific coordinates 
To move both the camera and its aiming point 
To rotate the camera around its aiming point 
To center the camera to view all objects 



Aiming the Camera
Rotating the Camera
Setting the Lens Angle



To move the camera by dragging

 
1 On the View menu, point to Point of View, and then click Four Up to display all four views.
2 In the Scene Explorer, click View to select the camera.

3 In the Toolbox, click the Move button , and then click the tool for the direction of camera movement you 
want.

4 In any view, drag to move the camera:
- In the Camera view, you move both the camera and its aiming point.
- In the Top, Side, or Front view, you move only the camera. Its aiming point remains stationary, and the 

camera rotates automatically to keep the aiming point centered.

{button Related Topics,PI(`',`RT_To_move_the_camera_by_dragging')}



To move the camera to specific coordinates 
To move both the camera and its aiming point 
To rotate the camera around its aiming point 
To aim the camera by dragging 

Moving the Camera
Aiming the Camera



To move the camera to specific coordinates
1 In the Scene Explorer, right-click View to display the camera's shortcut menu.
2 In the shortcut menu that appears, click Properties.
3 On the dialog box, enter new values for the camera’s X, Y, and Z coordinates.
Tip
· If you cannot see the camera in any of the Top, Side, or Front views, click the Smart Zoom tool  on the 

Standard toolbar.

{button Related Topics,PI(`',`RT_To_move_the_camera_numerically')}



To move the camera by dragging 
To move both the camera and its aiming point 
To rotate the camera around its aiming point 
To aim the camera by dragging 

Moving the Camera
Aiming the Camera



To move both the camera and its aiming point
1 In the Scene Explorer, click View to select the camera.

2 In the Toolbox, click the Move button , and then click the tool for the direction of camera movement you 
want.

3 In Camera view, drag the small set of crosshairs to move the camera.
Note
· You must use the Camera view to drag both the camera and its aiming point. In the Top, Side, or Front view, 

the aiming point remains stationary as you drag the camera.

{button Related Topics,PI(`',`RT_To_move_both_the_camera_and_its_aiming_point')}



To move the camera by dragging 
To move the camera to specific coordinates 
To rotate the camera around its aiming point 
To aim the camera by dragging 

Moving the Camera



To center the camera to view all objects
1 In the Scene Explorer, click View to select the camera.

2 In the Toolbox, click the Center button . Simply3D moves the camera as necessary to view all objects in 
the scene.

{button Related Topics,PI(`',`RT_To_center_the_camera_to_view_all_objects')}



To select the camera using the Scene Explorer 

Moving the Camera
Aiming the Camera
Rotating the Camera
Setting the Lens Angle



Aiming the Camera
{button Tell me how...,PI(`',`HT_Aiming_and_Rotating_the_Camera')}

The camera moves around an aiming point. Because it always aims directly at its aiming point, you can aim the 
camera in any direction by repositioning its aiming point.

 
You can aim the camera by:
· Dragging its aiming point in the Top, Side, or Front view.
· Specifying coordinates for the aiming point.
· Setting the aiming point on a target object.

Aiming point with specified coordinates 

Aiming point set on an object

{button Related Topics,PI(`',`RT_Aiming_and_Rotating_the_Camera')}



To aim the camera by dragging 
To aim the camera at specific coordinates 
To aim the camera at an object 



Moving the Camera
Rotating the Camera
Setting the Lens Angle



To aim the camera by dragging

 
1 On the View menu, point to Point of View, and then click Four Up to display all four views.
2 In the Scene Explorer, click View to select the camera.

3 In the Toolbox, click the Target button .
4 Drag in the Top, Side, or Front view to aim the camera. A small set of crosshairs shows the aiming point.
Tip
· You can also click to aim the camera. Clicking works in all four views, including the Camera view.

{button Related Topics,PI(`',`RT_To_aim_the_camera_by_dragging')}



To aim the camera at specific coordinates 
To aim the camera at an object 
To move the camera by dragging 
To move the camera to specific coordinates 

Aiming the Camera
Moving the Camera
Rotating the Camera



To aim the camera at specific coordinates
1 In the Scene Explorer, right-click View to display the camera's shortcut menu.
2 Click Properties to display the View Properties dialog box.
3 Under Target Location, type the X, Y, and Z coordinates of the aiming point. The camera will point to those 

coordinates until you specify a target object or aim the camera by dragging.

{button Related Topics,PI(`',`RT_To_lock_the_camera_on_a_point_in_space')}



To aim the camera by dragging 
To aim the camera at an object 
To move the camera by dragging 
To move the camera to specific coordinates 

Aiming the Camera
Moving the Camera
Rotating the Camera



To aim the camera at an object
1 In the Scene Explorer, right-click View to display the camera's shortcut menu.
2 Click Properties to display the View Properties dialog box.
3 Click the arrow  to show the list of objects in the scene.
4 Click the name of the object that you want to use as the camera’s target. The camera points to that object 

until you specify another object or aim the camera manually.
Note
· The camera remains aimed at the object while you move the camera, but not while you move or animate the 

object.

{button Related Topics,PI(`',`RT_To_lock_the_camera_on_a_specific_object')}



To aim the camera by dragging 
To aim the camera at specific coordinates 
To move the camera by dragging 
To move the camera to specific coordinates 

Aiming the Camera
Moving the Camera
Rotating the Camera



Rotating the Camera
{button Tell me how...,PI(`',`HT_Locking_the_Camera_on_a_Target')}

Besides using the Move tools to move the camera, you can also use the Rotate tools to move it. When you drag 
the camera using a rotate tool, the camera orbits its aiming point, maintaining a constant distance from the 
point.

 
The only camera rotation that is independent of moving is twisting. Working in Top or Side view, you can rotate 
the camera to tilt the scene’s horizon.

Camera and Rotation Rendered Scene
Camera not Rotated

Rendered Scene
Camera Rotated

Note
· If you want to aim the camera instead of rotating it, refer to Aiming the Camera in the Related Topics.

{button Related Topics,PI(`',`RT_Locking_the_Camera_on_a_Target')}



To select the camera using the Scene Explorer 
To rotate the camera around its aiming point 
To tilt the scene  ’  s horizon   



Moving the Camera
Aiming the Camera
Setting the Lens Angle



To rotate the camera around its aiming point

 
1 On the View menu, point to Point of View, and then click Four Up to display all four views.
2 In the Scene Explorer, click View to select the camera.

3 In the Toolbox, click the Rotation button , and then click the tool for the direction of camera rotation you 
want.

4 In any view, drag to rotate the camera.
Note
· As you rotate the camera around its aiming point, the camera automatically moves, maintaining a constant 

distance from its aiming point.

{button Related Topics,PI(`',`RT_To_rotate_the_camera_around_its_aiming_point')}



To tilt the scene  ’  s horizon   
To aim the camera by dragging 
To aim the camera at specific coordinates 
To aim the camera at an object 

Rotating the Camera
Aiming the Camera



To tilt the scene's horizon

 
1 On the View menu, point to Point of View, and then click Four Up to display all four views.
2 In the Scene Explorer, click View to select the camera.

3 In the Toolbox, click the Rotation button ,
4 Click either the Rotate left to right tool  for working in Top view, or the Rotate up and down tool 
 for working in Side view.

5 In either the Top or Side view, drag to rotate the camera.

{button Related Topics,PI(`',`RT_To_tilt_the_scene_s_horizon')}



To rotate the camera around its aiming point 
To aim the camera by dragging 
To aim the camera at specific coordinates 
To aim the camera at an object 

Rotating the Camera
Aiming the Camera



Setting the Lens Angle 
{button Tell me how...,PI(`',`HT_Setting_the_Lens_Angle')}

You can adjust the camera’s lens angle to change the amount of perspective seen through the camera lens. For 
example, a larger lens angle produces a wide-angle effect with increased perspective; a smaller lens angle 
produces a telephoto effect with decreased perspective.

 

Normal lens angle Wide angle (fisheye) Narrow angle (telephoto)

{button Related Topics,PI(`',`RT_Setting_the_Lens_Angle')}



To set the camera's lens angle by dragging 
To set the camera's lens angle numerically 



Moving the Camera
Aiming the Camera
Rotating the Camera



To set the camera's lens angle by dragging

 
1 On the View menu, point to Point of View, and then click Four Up to display all four views.
2 In the Scene Explorer, click View to select the camera.

3 In the Toolbox, click the Scale button .
4 In the project window, drag to change the lens angle.

{button Related Topics,PI(`',`RT_To_set_the_camera_s_lens_angle_by_dragging')}



To set the camera's lens angle numerically 

Setting the Lens Angle



To set the camera's lens angle numerically
1 In the Scene Explorer, right-click View. A shortcut menu appears.
2 Click Properties to display the Camera Properties dialog box.
3 In the Lens Angle box, type the new lens angle in degrees from the camera's centerline.

{button Related Topics,PI(`',`RT_To_set_the_camera_s_lens_angle_numerically')}



To set the camera's lens angle by dragging 

Setting the Lens Angle
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This document contains the context-sensitive topics for all Simply3D 3 windows and dialog boxes.



Shaping an Animation Path
{button Tell me how...,PI(`',`HT_IDH_Shaping_an_animation_path')}

The Animation Path editor gives you complete shaping control over the path of a move animation by letting you 
drag edit points distributed along the path.

When you right-click on an animated object or light (or on its animation in the Scene Explorer) and then click Modify
Animation Path, the Animation Path editor appears. A yellow line also appears in the project window to show the 
animation path of the selected object.

Follow Click this if you want the object to align with the path as it moves along the path.
Flip Click to flip the object. Effective only if you have chosen Follow, above.

 MoveClick to move edit points in the project window. When you point to an edit point, a box appears around it to
show that you can drag it to reshape the path.

 Edit Curve Linked Lets you reshape the path as a Bezier curve at any edit point. As you drag, the tangent 
for the selected point follows the mouse pointer.

 Edit Curve Unlinked Similar to the previous tool, except that you can drag one half of the tangent without 
disturbing the other half.

 Reset All Cancels your edits and restores the original animation path.
Keys Set this to the number of edit points you want distributed along the path. 

Tip
· For the most flexible editing control, select the Four-Up view before choosing to edit an animation path.

{button Related Topics,PI(`',`RT_IDH_Shaping_an_animation_path')}



To reposition or rotate the path of a move animation 
To scale the path of a move animation 
To animate an object using a catalog animation 
To animate an object using a wizard 
To preview the animations in a scene 



Previewing Animations 



Shaping a Text Path
{button Tell me how...,PI(`',`HT_IDH_Shaping_a_Text_Path')}

The Text Path editor gives you complete control over the shape of a text path by letting you drag edit points 
distributed along the path.

When you right-click on a 3D text object and click Modify Letter Path, the Text Path editor appears, and a red line 
appears in the project window to show the path of the selected text.

Select Path for Text Click the arrow , and select the starting path.
Follow Click this if you want the baseline of each letter to follow the shape of the path.
Flip Click to flip all the letters around their X axes. Effective only if you have chosen Follow, above.

 MoveClick to move edit points in the project window. When you point to an edit point, a box appears around it to
show that you can drag it to reshape the path.

 Edit Curve Linked Lets you reshape the path as a Bezier curve at any edit point. As you drag, the tangent 
for the selected point follows the mouse pointer.

 Edit Curve Unlinked Similar to the previous tool, except that you can drag one half of the tangent without 
disturbing the other half.

 Reset All Cancels your edits and restores the original text path.
Keys Set this to the number of edit points you want distributed along the path. Letters near an edit point move 
as you drag the point.

Tip
· For the most flexible editing control, select the Four-Up view before choosing to edit a text path.

{button Related Topics,PI(`',`RT_IDH_Shaping_a_Text_Path')}



To create 3D text 
To modify 3D text 
To animate text using the Text tool 



Creating and Modifying 3D Text 



Using the Scene Explorer
{button Tell me how...,PI(`',`HT_IDH_Using_the_Scene_Explorer')}

The Scene Explorer lists each resource (camera, object, light, and so on) in your scene. You can select a resource
by clicking it, display its shortcut menu by right-clicking it, and even rename it.

A "+" symbol accompanies each parent (a resource that contains other resources). To expand the list to show the 
resources belonging to the parent,    click the "+" symbol or double-click the parent. The list expands, and the 
symbol changes to a "-" symbol. Click the "-" symbol or double-click the parent to collapse the list again.
To select a resource, click it. The Scene Explorer uses highlighting to show which resources are selected. To select 
multiple resources of the same type, hold down the SHIFT or CTRL key as you click.

To display a resource's shortcut menu, right-click the resource.
To rearrange the hierarchy of an object, drag it to its new parent object.
To rename an item, click its name, pause briefly, and then click the name a second time.
To display the Scene Explorer as a separate window, drag it by its border. To restore the Scene Explorer to its 
most recent docked location, double-click its title bar.
Tip
· If you want to see a thumbnail image of each resource by pausing the pointer on the resource, click Options 

on the Tools menu, and then click the Scene Explorer Thumbnails option to select it.

{button Related Topics,PI(`',`RT_IDH_Using_the_Scene_Explorer')}



To show or hide the Scene Explorer 
To expand or collapse the resource list 
To rename resources in your scenes 
To show or hide pivot points in the Scene Expolorer



Parts of the Simply3D Window 
Building a Simply3D Scene 
Using a Simply3D Catalog 



Using a Simply3D Catalog
{button Tell me how...,PI(`',`HT_IDH_Using_a_Simply_3D_Catalog')}

Simply3D catalogs contain collections of related 3D objects, materials, animations, and lighting schemes. The 
catalog shows each available resource as a small thumbnail picture. The thumbnails for animations become 
animated when you rest the mouse pointer on them.

You add a catalog resource to your scene by either double-clicking its thumbnail or dragging it from the catalog and 
dropping it in the scene or Scene Explorer.

 
To view a specific resource type (Objects, Materials, Lights, and so on), click its tab at the top of the catalog. To 
select categories available within the selected type, click one of the tabs at the bottom of the catalog.
Notes
· If you don't see the catalog at the bottom of the project window, click the Show/Hide Catalog button  on 

the Standard toolbar.
· When dragging material to an object that contains more than one material: Either drop the new material on a

part of the object that contains the material you want to replace, or drop it on the material's name in the 
Scene Explorer. All parts of the object with matching material adopt the new material.

{button Related Topics,PI(`',`RT_IDH_Using_a_Simply_3D_Catalog')}



To show or hide the catalog 
To open a Simply3D catalog 



Parts of the Simply3D Window 
Building a Simply3D Scene 



Open

The Open dialog box lets you open a Simply3D project. It also lets you open other types of projects and import 
3D object files into your scene.

The effect of opening a file depends on the type of file.

File Extension Effect

S3D Opens the Simply3D project.

E3D Opens an Instant 3D project case as a Simply3D project.

EYE Opens a Renderize project file as a Simply3D project.

GED Opens a Visual 3D geometry file as a Simply3D object.

DXF Opens the 3D AutoCAD model as a Simply3D object
Note: Do not open 2D DXF files. Simply3D can only use DXF files that contain 3D objects. 

{button Related Topics,PI(`',`RT_DB_Open_dialog')}



Save As    
Print    
Using a Simply3D Catalog 



Save As

The Save As dialog box lets you save your 3D scenes. You can save a scene as a Simply3D project (S3D file), a 
bitmap file, an animation file, or even a 3D virtual "world" file for the World Wide Web. To select from a list of file 
types, click the arrow  and then click the type that you want to use.
Note
· You cannot convert the other formats back into an S3D file. To open the the scene in Simply3D, you must 

save it as a Simply3D Project.

Bitmap Images
When saving a scene as a bitmap image, you specify the height and width in pixels, and you select the color 
depth (from 256 to 16.7 million colors). If you want to save a specific frame of an animated scene as a bitmap 
image, use the Animation Control toolbar to display that frame before using the Save as command.
When you save a scene as a bitmap image, Simply3D saves the most recently rendered image unless you have 
made changes since you last rendered the scene.

Animation formats
The animation formats are listed only if you are saving a scene that contains one or more animations. When you 
click the Save button after selecting an animation format, a dialog box appears with options for that specific 
animation format.

{button Related Topics,PI(`',`RT_DB_SaveAs_dialog')}



Saving Scenes in Different File Formats 
Open    
Print    



Print
The Print dialog box lets you select which printer you want to use (if you have more than one), and it lets you set
some of the properties of the printer, such as paper size and print resolution.
You can choose to print the scene as a full-page, half-page, or quarter-page image. Simply3D scales the printed 
version of the scene as necessary.
Before printing the scene, Simply3D renders it in memory. A progress message appears while the scene is being 
rendered. You can cancel the print job by clicking the Cancel button.

{button Related Topics,PI(`',`RT_DB_Print_dialog')}



Save As    



Main window (any one)



This is a Simply3D project window.
To open a window for a new Simply3D project, select New on the File menu.    To choose objects, lighting, and so 
on for a scene, select Catalog on the View menu, select a catalog, and then drag items from the catalog into the 
project window.

To get help for a specific toolbar button or a menu item, click the Help button  on the Standard toolbar, and 
then click the button or menu item.



Project window (any one)



This is a project window, where you build a 3D scene.
· To choose objects, materials, lighting options, and animations for your scene, click Catalog on the View menu.
· To save the scene, click Save or Save As on the File menu.
· To get help with a specific toolbar button or a menu item, click the Help button  on the Standard toolbar, 

and then click the button or menu item.
· To view the Help table of contents, open the Help menu and click Simply3D Help.



Window controls



Shows the name of this window and provides an easy way to drag the window.



Reduces this window to a button. To restore the window, click the button.



Enlarges this window to its maximum size.



A scroll bar lets you use the mouse to bring other parts of the window into view. If the entire window is visible, 
the scrollbar controls are dimmed.



Provides a place for docking a toolbar.



Provides a place for docking a toolbar.



Provides a way to drag the Standard toolbar to a different location.



Provides a way to drag the Toolbox to a different location.



Provides a way to drag the Toolbox to a different location.



Provides a way to drag the Point of View toolbar to a different location.



Provides a way to drag the Point of View toolbar to a different location.



Provides a way to drag the Animation Control toolbar to a different location.



Provides a way to drag the Animation Control toolbar to a different location.



The Status Bar shows current information about your scene.
· As you move the object, the Status Bar shows the object's location as 3D coordinates.
· As you rotate the object, the Status Bar shows the relative rotation in all three axes.
· As you size the object, the Status Bar shows the object's scale along all three axes.
· As you adjust the camera's lens angle (with the Custom Lens Angle tool), the Status Bar shows the angle in 

degrees from the camera's centerline.
· During rendering, the Status Bar shows the task's progress.
The Status Bar also shows "hints" as you point to tools and menu items.



Set Aspect Ratio
This dialog box lets you choose the aspect ratio (width-to-height ratio) of your scene. You can choose from three 
pre-defined ratios, use a variable ratio, or specify a ratio of your choosing.
You can change the aspect ratio of a project at any time.
Controls

Ratio list Shows the list of choices for setting the aspect ratio. Click the arrow , and then click one of
the choices.
4 x 3 Sets the aspect ratio to 4 units wide by 3 units high.
3 x 4 Sets the aspect ratio to 3 units wide by 4 units high.
1 x 1 Sets a square aspect ratio.
Any Lets you vary the dimensions of your scene by dragging any corner of the 

project window.
User Defined Uses the values in the Height and Width boxes (below) as the aspect ratio.

Height, Width If you clicked User Defined, above, type the height and width that you want for your scene, in
pixels. (If Simply3D cannot create a window of the size you request, it creates a smaller 
window with the same aspect ratio.)

Save as Default Saves the aspect ratio as your default. The saved ratio will be used for new projects that you 
create.

{button Related Topics,PI(`',`RT_DB_SetAspectRatio_dialog')}



Display Options 
Modeling Options 
Color Options 
Animation Options 
Rendering Options 



Catalog Browser
This dialog box lets you open a Simply3D catalog. A typical Simply3D catalog contains 3D objects, materials you 
can use to cover objects, lighting schemes, and animations.
To open a catalog, click its name in the Catalog List, and then click OK. If Simply3D prompts you to insert the CD-
ROM, insert the CD-ROM, and click OK.
Controls

Catalog List Lists the Simply3D catalogs available.    Each catalog's icon tells you whether the catalog is 
installed on the hard disk or located on CD-ROM. 

Description Provides additional information about the selected catalog.
Browse Displays the Open dialog box to let you open a catalog from a folder of your choice.

{button Related Topics,PI(`',`RT_DB_CatalogBrowser_dialog')}



Using a Simply3D Catalog 
Using the Scene Explorer    
Display Options 
Modeling Options 
Color Options 
Animation Options 
Rendering Options 



Animation Editor
This editor lets you speed up and slow down animations, shift an object's animation along the timeline, reverse 
the direction of an animation.

Each object's animation is represented by an animation bar on the right side of the editor. Click the + symbols 
on the left to show the animation bar for the object you want to change.

 
You can drag the start point and the end point of an animation bar as necessary to shorten or lengthen the 
animation's duration. You can also drag the entire animation bar.

A right-click on an animation bar displays a shortcut menu that lets you turn the animation on and off, reverse 
the direction of an animation, adjust its timing numerically, and make the animation repeat (loop) a specified 
number of times.
Use the Scale slider at the upper-right corner of the Animation Editor to change the magnification of the time 
line.

{button Related Topics,PI(`',`RT_DB_AnimationEditor_dialog')}



Add/Subtract Scene Animation Frames    
Expand/Contract Animations    
Set Start and End Frames    
Loop Animation    



Toolbars dialog box
This dialog box lets you choose which toolbars Simply3D displays, how you want the buttons on the toolbars to 
look, and whether or not you want to see ToolTips when you pause the pointer on the buttons.
Click each item to turn it on or off, and then click OK to update the project window.
Toolbars

Standard Shows or hides the Standard toolbar. If you hide this toolbar, you can still access many of 
its tools by using menus.

Toolbox Shows or hides the Toolbox, which lets you move, rotate, and resize objects.
Point of View Shows or hides the Point of View toolbar, which lets you display the Camera view, Top 

view, Side view, Front view, or the Four Up view. Also contains buttons for zooming the 
Top, Side, and Front views.

Animation Control Shows or hides the Animation Control toolbar, which has VCR-like buttons for previewing 
your scene's animations. Simply3D shows this toolbar automatically when you first add an
animation to a scene.

Status Bar Shows or hides the Status bar at the bottom of the Simply3D Window. This bar displays 
useful messages and information as you work.

Other

Color Buttons Shows toolbar buttons in color or in black and white. Black and white button symbols may
be easier to interpret on some laptop computer screens.

Large Buttons Shows large or small toolbar buttons. Select this option if you have difficulty seeing the 
symbols on the toolbar buttons.

Show ToolTips Shows or hides the ToolTip that appears when you pause the pointer on a toolbar button.

{button Related Topics,PI(`',`RT_DB_Toolbars_dialog')}
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Tabs of the Options dialog box



Options dialog box, Display tab
This tab of the Options dialog box lets you set the default method that Simply3D uses to preview objects and the
method used to accelerate the scene preview in the Camera view.
Drawing Method

Wireframe Previews the object as a wireframe image.
Solid Shaded Previews the object as a solid, shaded image.
Four-Up View Displays all four views of the scene: Camera view, Top view, Side view, and Front 

view.
Bounding Box Previews the object as a bounding box as you drag it and as a wireframe image when

it is at rest.
Polygon Reduction Speeds up wireframe display by displaying only some of the object's polygons as you 

drag it.
Acceleration

Method Lists the display-acceleration options available on your system. Click the arrow  
and then click the method that you want.

Double Buffered Prevents the scene from flickering as you move, rotate, or scale its resources (camera, objects, 
lights, and animations).
Texture Map Previews objects complete with their materials. Available only if you select Solid Shaded 
previewing and either Direct3D or OpenGL® as the acceleration method.
Anti Alias Smooths the edges of objects while drawing them. Available only if you select Solid Shaded 
previewing and either Direct3D or OpenGL as the acceleration method.

Advanced Displays a dialog box of advanced options for Direct3D or OpenGL acceleration. The 
dialog box lets you bypass the 3D hardware acceleration of your graphics card. This 
button is enabled only if you select Direct3D or OpenGL as the drawing Method 
(above).

Other display items

Scene Explorer Thumbnails Select this option if you want to see thumbnail images of scene resources when you 
pause the pointer on their names in the Scene Explorer.

Show Startup Screen Shows or bypasses the Startup screen each time you start Simply3D.

{button Related Topics,PI(`',`RT_IDH_TAB_Options_db_Display_tab')}
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Options dialog box, Modeling tab
This tab of the Options dialog box lets you choose default settings for how you want to display and edit 3D 
objects.
Center on Import Forces imported 3D objects to appear in the center of the Simply3D "world."
Show Object Axes Displays labeled X, Y, and Z axes for each selected object in the scene.
Edit In-Place Lets you use the reshaping editors (Bend, Twist, Envelope, Push-Pull, and Extrude) by 

dragging in the view windows instead of using a separate dialog box.
Show Pivot Points Shows the pivot points of objects as selectable items in the Scene Explorer. After you 

click a pivot point, you can move and rotate it in the project window.
Write Command Stack Saves as part of the S3D file the list of reshaping actions applied to objects in the 

scene.
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Options dialog box, Colors tab
This tab of the Options dialog box lets you choose the default color scheme that you want Simply3D to use for 
previewing.
Gray, Black, or White Sets the preview colors for the Top, Side, and Front views. Does not affect the camera

view.

{button Related Topics,PI(`',`RT_IDH_TAB_Options_db_Color_tab')}
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Options dialog box, Animation tab
This tab of the Options dialog box lets you choose the default settings for animation playback.
Frames Per Second Sets the frame rate that Simply3D uses during playback. Enter the number of frames 

per second or click the arrows to increase or decrease the setting.

{button Related Topics,PI(`',`RT_IDH_TAB_Options_db_Animation_tab')}
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Options dialog box, Rendering tab
This tab of the Options dialog box lets you set default meanings for the Render Settings on the Tools menu.

Good, Better, and Best Select the settings you want for each of the 
Good, Better, and Best items of the Tools 
menu.

Mip Mapping – Improves the visual quality of 
textures.

Texture sampling – Makes materials appear 
less pixelated.

Anti Alias – Smooths the joints between 
materials on an object and smooths the edges
of objects against the background.

Super Anti Alias - Creates even smoother 
edges than the setting above, but takes 
more time.

Shadows Select whether or not you want Simply3D to 
render shadows by default. Shadows can 
significantly increase rendering time.
{button Note on 
shadows,PI(`',`Popup_note_on_shadows')}

Ray Bounces Type a number or click the arrows to set the 
number of bounces you want the ray-tracing
engine to track as it traces each ray of light. 
Higher numbers produce more realistic 
results but take longer. The default is 1. The 
maximum value is 4.

{button Related Topics,PI(`',`RT_IDH_TAB_Options_db_Rendering_tab')}
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VRML Export
This dialog box lets you create a VRML (Virtual Reality Modeling Language) world of your 3D scene as a WRL file 
for the Internet. Users with 3D browsers can move through your scene and click objects to link to other sites or 
VRML worlds.
Controls

Animation Options Lists options for storing animation information. Click the arrow , and then click the 
option that you want to use:

Key Frames Only¾Produces smallest WRL file but creates coarse approximations of amination paths.
Compress Frames¾Produces medium-size WRL files and medium-quality animation paths.
Every Frame¾Produces best animation paths but creates largest WRL files.

Image Export Type Lists options for storing animation information. Click the arrow , and then click the 
option that you want to use.

You can either embed the scene's image maps as part of the WRL file or store them 
as separate GIF, JPG, or PNG files on your Web server.

Compress To __ percent If you choose to store the scene's image maps as JPG files, set the JPEG compression 
level by dragging the slider or typing a percent in the box.

Subfolder for Images If you choose separate GIF, JPG, or PNG files for the scene's image maps, type the 
name of the subfolder in which you want them saved.

Open in Browser Lets you test the WRL file by opening it in your Web browser.
Save Embed Tag Creates an HTML file with the appropriate <Embed> tag to open the VRML file and 

display it in a window in your Web browser.
Copy Tag to Clipboard Copies the HTML <Embed> tag to the Clipboard so you can easily paste it into your 

HTML files.
Export as VRML 1.0 Select this option to exclude VRML 2.0 options (such as object animation) from the 

WRL file. Deselect this option if your users' browsers support VRML 2.0.
Image Width Type the width, in pixels, that you want the WRL scene to occupy on the user's 

screen.
Image Height Type the height, in pixels, that you want the WRL scene to occupy on the user's 

screen.

{button Related Topics,PI(`',`RT_DB_VRMLExport_dialog')}
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DXF Options
This dialog box appears when you open a DXF file to import its 3D model. 
Note: Do not open 2D DXF files. Simply3D can only use DXF files that contain 3D objects. 
Controls

Create Materials From Lets you assign materials for the imported objects by layer, color, or block. If you assign
materials by color, for example, Simply3D creates a unique material for each color in 
the DXF model.

Create Objects From Lets you specify how to divide the DXF model into objects. You can open the model by 
layer or color, or you can open the entire "block" as a single object. For example, if a 
model consists of multiple layers, you can choose to combine all the layers into a single
object.



Animated GIF Settings
This dialog box lets you specify how your animated scene should be displayed by Web browsers that handle 
animated GIF files.
Controls

Playback Frame Rate Drag this slider to set the maximum frame rate, in frames per second, that you 
want Web browsers to use when playing the animation. The message below the
slider describes the selected rate.

Playback Loops Drag this slider to set the number of times that you want the animation to 
repeat each time the HTML page is displayed. The message below the slider 
describes the current setting.

Make Background Transparent Select this option if you want the animation to show the HTML page as the 
background instead of showing the scene's background.

{button Related Topics,PI(`',`RT_DB_AnimatedGIFSettings_dialog')}
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Video Compression
This dialog box lets you specify the compression method used when you save an animated scene as an AVI file.
Controls

Compressor Lists the video compression methods available on your system. Click the arrow , 
and then click the method that you want to use.

Compression Quality Drag this slider toward the right for higher quality. Drag it toward the left for greater 
compression.
Key Frame Every __ frames A key frame contains all of the image data for the frame, rather than just the 
data for the changed pixels. More frequent key frames may make the animation images more accurate, but they 
add to the size of the AVI file. To specify key frames, click the option to select it, and then enter a value. 

Data Rate __ KB/sec Some AVI compression schemes let you specify the expected data-transfer rate at 
playback. The video compressor uses this information to determine how much 
information to include on each frame; with higher data rates, more information can 
be stored, and quality is better.

Configure This button may show additional configuration options, depending on the 
compression method selected.

About Shows information about the compression scheme, such as version number and 
developer name.

{button Related Topics,PI(`',`RT_DB_VideoCompression_dialog')}
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Rendering
Simply3D displays this message box while creating an animation file, such as an AVI, Animated GIF, or WRL file.
To cancel a rendering in progress, Click the Cancel button or press the ESC key.
Progress bars

Rendering Progress Shows the progress of each frame.
Animation Progress Shows the overall progress of the Save operation.

{button Related Topics,PI(`',`RT_DB_Rendering_dialog')}



Save As    
VRML Export    
Animated GIF Settings    
Video Compression    



Add/Subtract Scene Animation Frames
This dialog box gives you a way to either add empty animation frames or remove unused frames from the end of
your animated scene.
Enter the new number of total animation frames for the scene. If you are reducing the number of frames, 
Simply3D removes only unused frames at the end of the scene.

{button Related Topics,PI(`',`RT_DB_AddSubtractAnimFrames_dialog')}
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Expand/Contract Animations
This dialog box gives you a way to speed up or slow down all the animations in the scene by typing a new total 
frame count. 
To speed up all animations, enter a frame count that is smaller than the current total. To slow all animations, 
enter a count that is larger than the current total.

{button Related Topics,PI(`',`RT_DB_ExpandContractAnims_dialog')}
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Set Start and End Frames
This dialog box gives you a way to set the timing of an object's animation by typing the exact frames at which 
the animation starts and ends. The result is the same as dragging the animation's start point and end point to 
specific frame numbers.
Controls

Animation Starts at Frame Type the frame number or drag the slider to set the frame number at which you 
want the animation to start.

Animation Ends at Frame Type the frame number or drag the slider to set the frame number at which you 
want the animation to end. The maximum value is the scene's highest numbered 
frame. If you need more frames, you can add some at the end using the 
Add/Subtract Scene Animation Frames feature.

{button Related Topics,PI(`',`RT_DB_SetStartEndFrames_dialog')}
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Loop Animation
This dialog box lets you make an animation repeat. 
· If you want each repetition to use the same number of frames as the original animation, click the "Animation 

playlength is constant" option to select it, and then enter the number of times you want the animation to 
repeat after its first revolution. A value of 0 specifies no additional repetitions; the object will be animated 
through a single revolution. A value of 2 specifies two additional revolutions, or a total of three.

· You may need to add empty animation frames to make space for the repititions.
· If you want a complete series of    repetitions to fit in the same number of frames as the original animation, 

click "Auto downsize animation playlength" to select it, and then enter the number of times you want the 
animation to repeat. 

{button Related Topics,PI(`',`RT_DB_LoopAnim_dialog')}
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Modify Shape dialog box, Bend tab
This shaping editor lets you reshape a 3D object by bending, stretching, compressing, or otherwise distorting its 
main axis. You click the tool that you want to use. You then point to one of the keys on the axis to select it 
(indicated by highlighting), and drag to manipulate the axis.
Note
· If you have activated the Edit In-Place option, you can temporarily drag the camera image shown in the Side, 

Top, and Front views in order to see all sides of the object as you reshape it.
A large preview window shows an isometric (nonperspective) preview of the object, with the axis shown in red. 
Scroll bars let you rotate and magnify the object for viewing and reshaping purposes¾they do not change the 
original rotation of the object.
Toolbar

 Move Lets you bend the axis by moving the selected key. Use the bottom and right scroll bars to change
the direction of movement.

 Scale Moves all the vertices surrounding the selected key closer to or farther from the axis.
 Edit Curve Linked Lets you reshape the axis as a Bezier curve at the selected key. As you drag, the tangent 

for the selected key follows the mouse pointer.
 Edit Curve Unlinked Similar to the previous tool, except that you can drag one half of the tangent without 

disturbing the other half.
 Reset Cancels your axis-reshaping actions.

Axis

Control Points Lets you add or remove points along the axis that you can manipulate.

Preview and Acceleration Options
You can right-click in any of the shaping editors to display a shortcut menu for setting preview and acceleration 
options for the editor. 
Solid Shaded Previews the object as a solid, shaded image instead of as a wireframe. 
Draw Backface Polygons Available only if you are using software acceleration and you have not selected the 

Solid Shaded option, above.

{button Related Topics,PI(`',`RT_DB_AxisBend_dialog')}
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Modify Shape dialog box, Twist tab
This shaping editor lets you reshape a 3D object by twisting portions of its axis. You point to one of the keys on 
the axis to select it (indicated by highlighting). You can then use the tools on the editor to manipulate the axis.
Note
· If you have activated the Edit In-Place option, you can temporarily drag the camera image shown in the Side, 

Top, and Front views in order to see all sides of the object as you reshape it.
A large preview window shows an isometric (nonperspective) preview of the object, with the axis shown in red. 
Scroll bars let you rotate and magnify the object for viewing and reshaping purposes¾they do not change the 
original rotation of the object.
Toolbar

 Twist Rotates all the vertices surrounding the selected key around the axis.
 Reset Cancels your axis-reshaping actions.

Axis

Control Points Lets you add or remove points along the axis that you can manipulate.

Preview and Acceleration Options
You can right-click in any of the shaping editors to display a shortcut menu for setting preview and acceleration 
options for the editor. 
Solid Shaded Previews the object as a solid, shaded image instead of as a wireframe. 
Draw Backface Polygons Available only if you are using software acceleration and you have not selected the 

Solid Shaded option, above.

{button Related Topics,PI(`',`RT_DB_AxisTwist_dialog')}
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Modify Shape dialog box, Envelope tab
This shaping editor lets you reshape a 3D object indirectly by distorting its envelope, or box-shaped container. 
You drag a selection rectangle to define the envelope vertices that you want to manipulate. You can then use the
buttons.
Note
· If you have activated the Edit In-Place option, you can temporarily drag the camera image shown in the Side, 

Top, and Front views in order to see all sides of the object as you reshape it.
A large preview window shows an isometric (nonperspective) preview of the object. Scroll bars let you rotate and
magnify the object for viewing and reshaping purposes¾they do not change the original rotation of the object.
Toolbar

 Move Moves the selected envelope vertices. Use the bottom and right scroll bars to change the 
direction of movement.

 Rotate Z Lets you drag to rotate the selected envelope vertices around the object's Z axis. Use the Set 
Center of Change button 

 to move the point.
 Scale Scales the selected envelope vertices, similar to scaling an object.
 Set Center of Change Lets you reposition the envelope's center of change (shown as a small set of crosshairs). 

Click this button, and then click where you want the center.
 Sharp Click this button to make the envelope-reshaping effects produce sharply angled surfaces.
 Smooth Click this button to make the envelope-reshaping effects produce smoothly curved surfaces.
 Reset Cancels your envelope-reshaping actions.

Envelope Resolution

X, Y, and Z If you need to make finer changes to the shape of the envelope, increase these 
numbers before reshaping.

Preview and Acceleration Options
You can right-click in any of the shaping editors to display a shortcut menu for setting preview and acceleration 
options for the editor. 
Solid Shaded Previews the object as a solid, shaded image instead of as a wireframe. 
Draw Backface Polygons Available only if you are using software acceleration and you have not selected the 

Solid Shaded option, above.

{button Related Topics,PI(`',`RT_DB_EnvelopeEditor_dialog')}
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Modify Shape dialog box, Push-Pull tab
This shape editor lets you reshape an object by dragging a selection rectangle around its vertices and 
manipulating the vertices as a group. You can move, rotate, and scale the vertices, and you can deform the 
object as if it were elastic.
Note
· If you have activated the Edit In-Place option, you can temporarily drag the camera image shown in the Side, 

Top, and Front views in order to see all sides of the object as you reshape it.
A large preview window shows an isometric (nonperspective) preview of the object. Scroll bars let you rotate and
magnify the object for viewing and reshaping purposes¾they do not change the original rotation of the object.
Toolbar

 Move Moves the selected object vertices. Use the bottom and right scroll bars to change the direction of
movement.

 Rotate Z Lets you drag to rotate the selected object vertices around the object's Z axis. Use the Set Center 
of Change button 

 to move the point.
 Scale Scales the selected object vertices, similar to scaling an object.
 Set Center of Change Lets you reposition the object's center of change (shown as a small set of crosshairs). 

Click this button, and then click where you want the point.
 Area Lets you drag to resize the area of influence (shown as a sphere). Vertices outside this sphere are not 

affected by the push-pull tools. This button is enabled only when you select Smooth 
 reshaping.
 Sharp Click this button to turn off the area of influence and its elastic effects. All selected objects are 

equally affected by moving, scaling, and rotating.
 Smooth Click this button to display the sphere for the area of influence and produce elastic effects as you 

move, scale, and rotate the selected vertices.
 Reset Cancels your reshaping actions.

Slack

If you clicked Smooth, you can drag this slider toward the left to make the object more malleable. Drag it toward 
the right to make the object more rigid.

Preview and Acceleration Options
You can right-click in any of the shaping editors to display a shortcut menu for setting preview and acceleration 
options for the editor. 
Solid Shaded Previews the object as a solid, shaded image instead of as a wireframe. 
Draw Backface Polygons Available only if you are using software acceleration and you have not selected the 

Solid Shaded option, above.

{button Related Topics,PI(`',`RT_DB_PushPullEditor_dialog')}
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Modify Shape dialog box, Extrude tab
This shaping editor lets you reshape a 3D object by dragging a selection rectangle around its vertices and 
manipulating the vertices as a group. The effect is similar to that of the Push-Pull editor, except that surrounding 
vertices are not affected.
Notes
· For text, the Extrusion editor adjusts the depth of the characters, an effect that might not be visible in a 

head-on view. To see the change, drag the right-hand scrollbar slider up or down.
· If you have activated the Edit In-Place option, you can temporarily drag the camera image shown in the Side, 

Top, and Front views in order to see all sides of the object as you reshape it.
A large preview window shows an isometric (nonperspective) preview of the object, with the axis shown in red. 
Scroll bars let you rotate and magnify the object for viewing and reshaping purposes¾they do not change the 
original rotation of the object.
Toolbar

 Extrude Moves the selected vertices directly away from or toward the center of the object.
 Move Moves the selected object vertices in any direction. Use the bottom and right scroll bars to change

the direction of movement.
 Reset Cancels your extrusion actions.

Preview and Acceleration Options
You can right-click in any of the shaping editors to display a shortcut menu for setting preview and acceleration 
options for the editor. 
Solid Shaded Previews the object as a solid, shaded image instead of as a wireframe. 
Draw Backface Polygons Available only if you are using software acceleration and you have not selected the 

Solid Shaded option, above.

{button Related Topics,PI(`',`RT_DB_Extrude_dialog')}
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Profile Creation tool
This tool lets you create a new Simply3D shape from one of eight starting shapes by dragging to mold the top 
profile and side profiles. Note that you cannot use this tool on Simply3D catalog objects, Simply3D primitives, or 
objects imported from other formats.
Note
· You can right-click in the preview box to display a shortcut menu for setting preview and 3D acceleration 

options for the editor. Information about these options is available under the help topic Reshaping a 3D 
Object. 

Three preview windows show isometric (nonperspective) previews of the object. Scroll bars let you rotate and 
magnify the object for viewing purposes only¾they do not change the original rotation of the object.
Shapes Toolbar

Click the shape that you want to use as a starting shape.
Action Toolbar

 Pick Lets you distort the object by moving the selected key or pair of keys. Use the bottom and right scroll bars 
to change the direction of movement.

 Edit Curve Linked Lets you reshape the axis as a Bezier curve at the selected key. As you drag, the tangent 
for the selected key follows the mouse pointer.

 Edit Curve Unlinked Similar to the previous tool, except that you can drag one half of the tangent without 
disturbing the other half.

 Pan View Lets you drag the object in the section or profile window.
 Reset All Cancels your profile-reshaping actions.

Section

Separate Section Select this option if you want reshaping to affect only the active key's section 
instead of all sections.

Linear Section Select this option to eliminate the curvature at the section keys. You can still 
achieve rounded shapes by adding keys, provided the additional complexity is 
acceptable.

Divisions Type the number of divisions that you want between each pair of section keys. 
Higher values result in a more flexible¾but more complex¾object.

Keys Type the number of keys (points you can manipulate) that you want the section 
window to display.

 Reset Section Cancels all changes you have made to all the sections.
 Reset Section Curve Cancels only the changes you have made to the currently selected section key.

Profile

Thickness Drag this slider to quickly give an open object thickness. Creating thickness 
approximately doubles the complexity of the object.

Linear Profile Select this option to eliminate the curvature at the profile keys. You can still 
achieve rounded shapes by adding keys, provided the additional complexity is 
acceptable.

Divisions Type the number of divisions that you want between each pair of profile keys. 
Higher values result in a more flexible¾but more complex¾object.

Keys Type the number of keys (points you can manipulate) that you want the profile 
window to display.

Mirror, Symmetric, Asymmetric Click Mirror to make an adjacent key act as a mirror image when you drag the 
active key. Click Symmetric to make the two keys move in the same direction. 
Click Asymmetric to drag a single key.

 Reset Profile Cancels all changes you have made to the profile.
 Reset Profile Curve Cancels only the changes you have made to the currently selected profile key.

Other

Top Cap Removes or restores the top cap of the object.



Bottom Cap Removes or restores the bottom cap of the object.

{button Related Topics,PI(`',`RT_DB_ProfileEditor_dialog')}
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Camera Properties
This dialog box lets you position the camera at precise "world" coordinates. It also lets you set the camera's 
aiming point at a precise point in space or at a specific object in the scene.
You can right-click on the Background preview to change the background color or specify an image as the 
background, and you can adjust the camera's lens angle numerically.
Camera Location

X, Y, and Z These boxes show the X, Y, and Z coordinates of the camera's current location. To move the 
camera to specific coordinates, type the new coordinate values.

Target Location

X, Y, and Z These boxes show the X, Y, and Z coordinates of the camera's current aiming point. To aim the
camera at a specific point in space, type the new coordinate values.

Target Object Lists each object in the scene so you can set the camera's aiming point at a specific object. 
Click the arrow , and then click the name of the object.

Note: The camera's aiming point remains locked on the target object when you move the object manually 
or move the camera in the Top, Side, or Front view.    However, the camera does not follow an animated target 
object. Also, if you want the aiming point to remain on the target object while you are using Camera view, you must
use the Rotate tools instead of the Move tools. Note that the Rotate tools don't let you change the distance between
the camera and its aiming point.

Other

Background This thumbnail picture shows the current background image or color. Right-click the thumbnail
to display a shortcut menu for the scene's background. The menu lets you specify a solid 
Color, Browse for a background image, Restore the previous image (before clicking OK), or 
Clear the image. You can also Cut, Copy, and Paste the background image.
The default is a solid black background.

Lens Angle Type an angle in degrees from the camera's centerline. A small angle produces a telephoto 
effect; a large angle produces a fisheye-lens effect.

{button Related Topics,PI(`',`RT_DB_CameraProperties_dialog')}
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Light Properties
This dialog box lets you position a light at precise "world" coordinates. It also lets you aim the light at a precise 
point in space or at a specific object in the scene.
You can make the light act as a point light (a light bulb) or a spotlight, adjust its brightness, and change its color.
Shadow options let you specify whether or not the light casts shadows. You can choose the shadow-rendering 
method.
Light Location

X, Y, and Z These boxes show the X, Y, and Z coordinates of the light's current location. To move the 
light to specific coordinates, type the new coordinate values.

Target Location

X, Y, and Z These boxes show the current X, Y, and Z coordinates of the light's aiming point. To 
temporarily aim the light at a specific point in space, type the new coordinate values.

Lock Light on Location Locks the light's aiming point on the current X, Y, and Z coordinates.
Target Object Lists each object in the scene so you can set the light's aiming point at a specific object. 

Click the arrow  and then click the name of the object.
Lock Light on Target Makes the light's aiming point follow the target object as you move or animate the 
object.

Color

Sample swatch Shows a sample of the light's color.
Change button Displays the Color Palette dialog box to let you change the light's color. The default color 

for lights is white.
Brightness Drag this slider to the left to make the light dimmer; drag to the right to make it brighter.
Type

Point light, Spotlight Shows the type of light. Click Point Light for a light that extends in all directions. Click 
Spotlight for a light that is focused in one direction.

Attach Light to Object Lets you make the light move in 
unison with a selected object in the scene. Note that the light's aiming point can be 
locked on a different location or target object.

Shadows {button Note on shadows,PI(`',`Popup_note_on_shadows')}
Cast Shadows Activate this option to make the light cast shadows. Deactivate it if you want the light to 

illuminate objects without casting their shadows.
Ray-Traced Shadows Select this option if you want Simply3D to use ray tracing to create highly realistic 

shadows. Ray-Traced shadows take longer than Shadow-Mapped shadows.
Shadow Mapped Select this option for the fastest shadow rendering. This method also lets you use the 

Shadow Map Size setting to soften shadow edges. 
Shadow Bias Enter a value within the range 0.000 through 1.000. Values too close to 0 can produce 

strange patterns, and values too high produce shadows that do not meet their origin. The 
default value is 0.100

Shadow Map Size This value controls the sharpness of shadow edges. Small values produce soft edges, and 
large values produce sharp edges. The default value is 400.

{button Related Topics,PI(`',`RT_DB_LightProperties_dialog')}



Setting a Light  ’  s Shadow Properties     
Adding and Removing Lights     
Moving and Aiming Lights 
Using the Scene Explorer    



The Object Properties dialog box



Object Properties, General tab
This dialog box gives you numeric equivalents to using the mouse for moving, rotating, and scaling objects. You 
can also specify rendering options that control the smoothness of an object's surface, how its image maps are 
applied to the surface, and how it handles shadows. An Internet tab lets you make the object an interactive 
component of a virtual-reality world.
The General tab lets you type numeric values to set the object's location, rotation, and scale. You can also 
choose options for smoothness and shadows.
Object Location

X, Y, and Z These boxes show the X, Y, and Z coordinates of the light's current location. To move the 
light to specific coordinates, type the new coordinate values.

Object Scale

X, Y, and Z These boxes show the object's current X, Y, and Z scale. To change the scale, type the 
new value or values.
The X, Y, and Z scale labels refer to the object's axes, which rotate with the object. To see 
the axes, select the object, click Options on the Tools menu, and then click Draw Object 
Axes.

Object Rotation

X, Y, and Z These boxes show the rotation of the object's X, Y, and Z axes, measured from the 
scene's axes. To change the rotation, type the new value or values.

Other {button Note on shadows,PI(`',`Popup_note_on_shadows')}
Cast Shadows Deactivate this option if you want lights in the scene to illuminate the object but not cast 

shadows of it.
Receive Shadows Deactivate this option if you don't want the shadows of other objects to fall on this object.
Render Backface Activate this option if you want to see the inside of an open object (such as a wall or 

vase) or the inside of a semitransparent closed object (such as a sphere). Rendering takes
longer with this option activated.

Smooth Activate this option if you want the surface to appear rounded. Smoothing is a rendering 
effect; the object's geometry does not change.

Angle If you activate smoothing but you want to limit the smoothing effect, activate this option 
and then type an angle in the box. Smoothing is not applied to angles greater than the 
angle you type.

Material Crease Select this option if you have activated smoothing for the object, but you want to see 
sharp creases between polygons of different materials.    Smoothing occurs only for 
adjacent polygons covered with the same material.

{button Related Topics,PI(`',`RT_TAB_ObjectProperties_db_General_tab')}



Object Properties, Mapping tab    
Object Properties, Internet tab    
Reshaping a 3D Object 



Object Properties, Mapping tab
The Mapping tab lets you control how Simply3D maps the images assigned to the object's materials. Note that 
the settings on this tab affect all materials on the object.
Controls

Mapping Type Lists the available mapping methods. Click the arrow , and then click the method that you
want. The same method is used for the object's    texture maps, image reflection maps, and 
bump maps.

Image Repeat Click one of these options to specify how you want images in the object's material to be repeated,
or tiled, when the image is smaller than the object.

Stamp¾Select this option if you are using an image designed to be repeated without showing any visible 
seams between the repetitions.

Flip¾Select this option if you want to hide the seams when tiling an image that was not 
designed for seamless repetition. Simply3D attempts to hide the seams by alternating the 
normal orientation of the image with a flipped orientation.
Decal¾Select this option if you want a single, opaque copy of the image mapped to the 
object. Note that with this option, material color doesn't tint the image, but is applied to all 
the remaining parts of the object. The mapping engine ignores the material's transparency 
setting.

{button Related Topics,PI(`',`RT_TAB_ObjectProperties_db_Mapping_tab')}



Object Properties, General tab    
Object Properties, Internet tab    
Changing the Appearance of an Object's Surface 
Reshaping a 3D Object 



Object Properties, Internet tab
The Internet tab lets you specify how the object behaves if you include it in a scene that you save as a VRML 
(Virtual Reality Modeling Language) file.
Controls

Target URL Type the Internet (or Intranet) URL that you want to become the object's target. For 
example, type http://w3.ourcompany.com/page2.htm. When users who browse your 
scene with a VRML browser click the object, they are transported to the target URL.

Target Description Type a short description of the object's target. For example, type Click to go to our 
company's home page. Some browsers display this description in their status bar when 
users move the mouse pointer onto the object.

{button Related Topics,PI(`',`RT_TAB_ObjectProperties_db_Internet_tab')}
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Save As    
Reshaping a 3D Object 



The Material editor



Material Editor, Surface tab
The Material editor lets you control many characteristics of the materials that cover Simply3D objects. You can 
apply bitmap images to a material in several ways, specify the color and shininess of a material, set how the 
material reflects and refracts light, and even adjust the material's transparency.
The Surface tab lets you set the material's color, its shininess, and its texture map and bump map.
Controls

Preview box Shows a sample of the material. The sample is updated automatically as you change 
settings. Drag the scrollbar sliders to rotate and magnify the preview.

Material selection list For objects that have multiple materials, click the icon for the specific material you want 
to change.

Material Color Shows a color swatch of the material's color. If the material has a texture map, this color 
lightens, darkens, or tints the image. To set the color, click the Change button.

Shiny Color Shows a color swatch of the material's shiny color. To set the color, click the Change 
button.

Material Shininess Shows the shininess setting of the material. To change the shininess, drag the slider or 
type a value in the range 0.00 through 1.00. The preview sample shows the effect.

Transparency Level Drag the slider or type a transparency value in the range 0.00 through 1.00. The preview 
sample shows the changes.

Highlight Size To change the material's highlight size, drag the slider or type a value in the range 0.00 
through 5.00. The preview sample shows the effect.

Edge Transparency Drag the slider or type a value in the range 0.00 through 1.00. The preview sample shows
the changes.

{button Related Topics,PI(`',`RT_TAB_MaterialProperties_db_Surface_tab')}



Material editor, Texture tab    
Material editor, Bump tab    
Material editor, Reflection tab    
Light Properties    
Object Properties, Mapping tab    



Material Editor, Texture tab
The Texture tab lets you use a bitmap image or an animation file as material for covering objects. You can control
how the image is scaled and positioned on the objects. This tab also contains buttons for cutting, copying, 
pasting from the Clipboard and for browsing for a bitmap file.
Preview box Shows a sample of the material. The sample is updated automatically as you change 

settings. Drag the scrollbar sliders to rotate and magnify the preview.
Material selection list For objects that have multiple materials, click the icon for the specific material you want 

to change.
Material Color Shows a color swatch of the material's color. If the material has a texture map, this color 

lightens, darkens, or tints the image. To set the color, click the Change button.
Shiny Color Shows a color swatch of the material's shiny color. To set the color, click the Change 

button.
Texture Map Shows a thumbnail of the material's bitmap image or the first frame of its animation. You 

can Cut, Copy, and Paste the texture map, and you can open a bitmap file from a disk 
drive. To remove the texture map, click the Cut button.

Map Blur Specifies how much you want to soften the boundaries between contrasting colors in the 
image. Drag the slider or type a value in the box. The default value is 1.

Use Alpha If you select this option when the texture map for your material contains an Alpha 
channel, you apply your transparency settings directly to the Alpha channel. If you do not 
select this option (or you select it when the image has no Alpha channel), you apply your 
transparency setting to the entire image.
Note: An Alpha channel contains pixel-by-pixel transparency information. Programs that 
let you create an Alpha channel (such as Micrografx Picture Publisher) let you use the 
channel to make parts of the image more transparent than other parts. Simply3D 
supports Alpha channel information in TIF files and in Picture Publisher PP5 and PPF files.

Map Scale Lets you shrink (values less than 1) or magnify (values greater than 1) the texture map. 
Either drag the slider or type a value in the box. Small values cause the image to be tiled 
across the object to which you apply the material. You can adjust the image's width and 
height together or separately.
Click the Lock Bump Map option if you are using a bump map and you want to scale it 
identically to the texture map.

Map Position Lets you adjust the starting X and Y positions of the image. Either drag the slider or type 
a value in the box.
Click the Lock Bump Map option if you are using a bump map and you want to position it 
identically to the texture map.

{button Related Topics,PI(`',`RT_TAB_MaterialProperties_db_Texture_tab')}
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Material Editor, Bump tab
The Bump tab lets you use a bitmap image to give apparent thickness to a material. Lighter colored areas of the 
image appear as "hills," and darker colored areas as "valleys." As with the texture map, you can control how the 
bump image is scaled and positioned on the objects. 
Preview box Shows a sample of the material. The sample is updated automatically as you change 

settings. Drag the scrollbar sliders to rotate and magnify the preview.
Material selection list For objects that have multiple materials, click the icon for the specific material you want 

to change.
Material Color Shows a color swatch of the material's color. If the material has a texture map, this color 

lightens, darkens, or tints the image. To set the color, click the Change button.
Shiny Color Shows a color swatch of the material's shiny color. To set the color, click the Change 

button.
Bump Map Shows a thumbnail of the bitmap or the first frame of the animation assigned as the 

material's bump map. You can Cut, Copy, and Paste the bump map, and you can open a 
bitmap file from a disk drive. To remove the bump map, click the Cut button.

Map Blur Specifies how much you want to soften the boundaries between contrasting colors in the 
image. Drag the slider or type a value in the box. The default value is 1.

Map Bump Height Controls the apparent height of the bumps. Drag the slider or type a value in the box. 
Negative values reverse the effect of the bump map. The default value is 1.

Map Scale Lets you shrink (values less than 1) or magnify (values greater than 1) the bump map. 
Either drag the slider or type a value in the box. Small values cause the image to be tiled 
across the object to which you apply the material. You can adjust the image's width and 
height together or separately.
Click the Lock Texture Map option if you are using a texture map and you want to scale it 
identically to the bump map.

Map Position Lets you adjust the starting X and Y positions of the image. Either drag the slider or type 
a value in the box.
Click the Lock Texture Map option if you are using a texture map and you want to position 
it identically to the bump map.

{button Related Topics,PI(`',`RT_TAB_MaterialProperties_db_Bump_tab')}
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Material Editor, Reflection tab
The Reflection tab let you control the reflective characteristics of a shiny material (material with a Shininess 
setting greater than 0).
Preview box Shows a sample of the material. The sample is updated automatically as you change 

settings. Drag the scrollbar sliders to rotate and magnify the preview.
Material selection list For objects that have multiple materials, click the icon for the specific material you want 

to change.
Material Color Shows a color swatch of the material's color. If the material has a texture map, this color 

lightens, darkens, or tints the image. To set the color, click the Change button.
Shiny Color Shows a color swatch of the material's shiny color. To set the color, click the Change 

button.
Image Reflect In the rendered scene, this bitmap image or animation shows as a reflection in shiny 

materials when you choose image reflection rather than ray tracing. This preview shows a
thumbnail of the material's image reflection map or the first frame of the animation. You 
can Cut, Copy, and Paste the reflection map, and you can open a bitmap file from a disk 
drive. To remove the reflection map, click the Cut button.

Reflect Blur Controls how much the reflected image is blurred. Drag the slider or type a value in the 
box. The default value is 1.

Reflect Color Shows a color swatch of the material's reflection color. You can assign a color to lighten, 
darken, or tint the image reflection map. To set the color, click the Change button.

Use Ray Tracing When selected, uses ray tracing to render reflections of a shiny material's actual 
surroundings instead of using an image reflection map.

Ray Reflect Adjusts the material's reflectivity for ray-tracing purposes. To adjust, select the Use Ray 
Tracing option, and then drag the slider or type a value in the range 0.000 through 1.000.

Ray Refraction Level Adjusts the material's refraction. To adjust, select the Use Ray Tracing option, and then 
drag the slider or type a value in the range 0.80 through 2.00.

{button Related Topics,PI(`',`RT_TAB_MaterialProperties_db_Reflection_tab')}
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About Simply3D screen
This screen tells you the version number, date, and other information about your copy of Simply3D. This 
information may help you determine whether or not you need to upgrade in the future.
To close the screen, click OK or press the ENTER key.
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CSH_Menu.DOC
This document contains the context-sensitive popup topics for all Simply3D menu and submenu items.



Common menu (and button) commands



Removes the selected resource from the scene and places it in the Windows Clipboard.



Copies the selected resource to the Windows Clipboard.



Pastes the contents of the Clipboard into the active project.



Displays the Properties dialog box for the currently selected scene resource (camera, object, material, animation,
or light). If you have selected more than one resource, displays the Camera Properties dialog box.



Commmon shortcut menu items



Shows or hides the selected object, animation, or light. 
· Hiding an object prevents it from being rendered or shown in any of the views.    A hidden object is visible 

only in the Scene Explorer. Hiding a parent object automatically hides its child objects.
· Hiding an animation suspends the animation of its object. Hiding a parent object's animation, however, does 

not suspend the animations of its child objects.
· Hiding a light prevents it from illuminating the scene. A hidden light is visible only in the Scene Explorer.



Lets you type a new name for the currently selected object, material, light, animation, or deformation.



Camera shortcut menu items



Copies the entire scene, including all scene resources, to the Clipboard.



Pastes an entire scene, including all scene resources, from the Clipboard.



Displays a dialog box that lets you change the properties (location, target, lens angle) of the camera.



Object shortcut menu items



Displays the currently selected 3D text in the Text tool so you can edit the text, its font, and other properties.



Displays the currently selected 3D text or extruded 2D object in the Extrusion tool so you can select a bevel type
and change other properties of the object.



Displays a wizard page that lets you select materials from a list. The material you select is applied to the 
currently selected object.



Displays a wizard page that lets you select an animation from a list. The animation you select is applied to the 
currently selected object.



Displays the Path page of the text tool so you can choose a path for the letters of the currently selected 3D text.



Opens the Twist editor, which lets you reshape an object by twisting selected points on its axis.



Opens the Bend editor, which lets you reshape an object by bending its axis.



Opens the Envelope editor, which lets you reshape an object by distorting its bounding box.



Opens the Push-Pull editor, which lets you reshape an object by dragging specific points or groups of points on 
the object.



Opens the Extrusion editor, which lets you reshape an object by dragging specific points or groups of points on 
the object. This editor is similar to the Push-Pull editor, except that surrounding vertices are not affected.



Copies the currently selected object to the Clipboard and then removes it from the scene.



Copies the currently selected object to the Clipboard.



Replaces the currently selected object with the object on the Clipboard.



Displays the Path page of the Text tool so you can choose a path for the letters of the currently selected 3D text.



Displays a path editor that lets you reshape an object's animation path by dragging points distributed along the 
path.



Displays the Animation editor and adds a "morph" animation bar for animated reshaping of the currently 
selected object.
You use the buttons on the Animation editor to apply Simply3D reshaping commands (such as Bend, Twist, and 
Extrude) to the animation bar at specific frames. When you play the animation, Simply3D automatically creates 
the intermediate shapes necessary to smooth the changes from shape to shape.



Creates a parent object for the currently selected object. With a parent object, you can create a group of objects 
by dropping other objects on the parent. 
When you move, rotate, scale, or animate a parent object, you automatically perform the same operation on all 
of its child objects. Parent objects are visible only in the Scene Explorer.
Note
· Although you can move, rotate, scale, and animate objects grouped under a parent by manipulating the 

parent, you cannot change other object properties (such as material) by selecting the parent; you must select
the child objects.



Separates the letters of a 3D text object so that you can manipulate them as individual objects and assign 
different properties and actions to them. 
The letters remain children of the original text object so you can still manipulate them as a single object.



Displays a dialog box that lets you change the properties of the currently selected object.
You can change the object's location, rotation, scale, shadow casting, texture mapping type, and target Internet 
URL.



Group lets you fold up the children of a parent object into the parent so that they do not appear as objects in the 
Scene Explorer.
Ungroup lets you unfold the grouped children of a parent object so that they appear as objects in the Scene 
Explorer.



Animation and Deformation shortcut menu items



Displays a path editor that lets you reshape an animation's path by dragging points distributed along the path.



Copies the currently selected animation to the Clipboard and then removes it from the scene.



Copies the currently selected animation to the Clipboard.



Replaces the currently selected animation with the animation on the Cipboard.



Displays the Animation editor.



Background shortcut menu items



Displays the Open dialog box to let you specify a bitmap file to be used as the scene's background image.



Displays the color picker so you can specify a color for the scene's background. If you have specified a bitmap 
image as the background, the solid color replaces the image.



Copies the scene background to the Clipboard as a bitmap image.



Copies the scene background to the Clipboard and then clears the background to solid black.



Replaces the background with the Clipboard contents. The Clipboard must contain a bitmap image or a 
background.



Clears the background to solid black.



Material shortcut menu items



Copies the currently selected material to the Clipboard.



Replaces the currently selected material with the Clipboard contents.



Displays the Surface tab of the Material editor so you can change the color and other properties of the selected 
material. If the material has a texture, the image is tinted with the color.



Displays the Surface tab of the Material editor so you can change the transparency and other properties of the 
currently selected material.



Displays the Surface tab of the Material editor so you can change the shininess and other properties of the 
currently selected material.



Displays the Texture tab of the Material editor so you can change the image, scale, and position of the texture 
map for the currently selected material.



Displays the Bump tab of the Material editor so you can change the image, scale, and position of the bump map 
for the currently selected material.



Displays the Reflection tab of the Material editor. You can specify whether you want the material to reflect a 
specific image or to use ray tracing to reflect its surroundings in the scene. If you select ray tracing, you can set 
the refraction property of the material. The refraction setting affects semi-transparent materials.



Pivit Point shortcut menu item



Restores the object's pivot point to its original position.



Light shortcut menu items



Makes the currently selected light a point light. A point light is like a light bulb. It radiates light equally in all 
directions.



Makes the currently selected light a spotlight. A spotlight radiates light in a specific direction.



Displays a dialog box that lets you change the color of the currently selected light.



Temporarily locks the beam of the currently selected light on the light's target. The light remains aimed at the 
target as you move the light. If you have used the Light Properties dialog box to set a specific object as the 
light's target, the light remains aimed at the object as you move or animate the target object.
Notes
· Dragging the light beam unlocks it.
· If you want the light to move with a specific object, right-click the light, click Properties, click the arrow under 

Attach Light to Object, and click the object. The object doesn't have to be the light's target object.



Lets you control whether or not the currently selected light casts shadows.
Simply3D shadows:
· Are visible only when you render the scene, and only if you activate shadows through the Tools/Render 

Settings menu item.
· Are cast only if the object is set to cast shadows.
· Are cast only by lights that are set to cast shadows.
· Fall only on objects that are set to receive shadows.
· Never show on the scene's background.



Copies the currently selected light to the Clipboard and then removes it from the scene. You cannot remove the 
last remaining light, however.



Copies the currently selected light to the Clipboard.



Replaces the currently selected light with a light from the Clipboard. Available only if you have copied or cut a 
light to the Clipboard.



Displays a dialog box that lets you change the properties (location, target, brightness, shadow rendering) of the 
currently selected light.



System menus (for the main window and any child window)



Restores this window from maximized to its previous size and location.



Lets you move this window using the arrow keys on the keyboard.



Lets you change the size of this window using the arrow keys on the keyboard.



Reduces this window to a button. To restore the window, click the button.



Enlarges this window to its maximum size.



Closes all open projects and then exits Simply3D.
If you have made changes to a project, Simply3D prompts you to save the changes before the project's window 
closes.



File menu



Creates a new, empty Simply3D scene (Keyboard shortcut CTRL+N). The new scene is untitled until you save it.



Opens the Project wizard so you can use it to create a new scene.



Displays the File Open dialog box, which lets you open a previously saved Simply3D scene. (Keyboard shortcut 
CTRL+O) The folder shown is the last folder in which a Simply3D scene was opened.



Closes the active Simply3D scene. If you have made changes that you have not saved, Close prompts you to 
save the changes.



Saves the currently active scene. 
Note
· If this is the first time you have saved the scene, Save displays the Save As dialog box to let you give the 

scene a file name.



Opens a dialog box that lets you assign a file name to the current scene or make a copy of the scene under a 
different file name.



Displays the Aspect Ratio dialog box to let you set a fixed or variable height-to-width ratio for your scene.



Displays the Print dialog box to let you print the current scene. Also lets you change the target printer.



Prepares the current Simply3D scene to be sent as electronic mail.
Note
· This item is enabled only if you have installed a MAPI-compatible mail program (such as Microsoft Mail).



This is the name of an Simply3D project you have used recently. You can open it by clicking its name in the File 
menu, provided you have not renamed or moved it since you last used it.



This is the name of an Simply3D project you have used recently. You can open it by clicking its name in the File 
menu, provided you have not renamed or moved it since you last used it.



This is the name of an Simply3D project you have used recently. You can open it by clicking its name in the File 
menu, provided you have not renamed or moved it since you last used it.



This is the name of an Simply3D project you have used recently. You can open it by clicking its name in the File 
menu, provided you have not renamed or moved it since you last used it.



Closes all open projects and then exits Simply3D.
If you have made changes to a project, Simply3D prompts you to save the changes before the project's window 
closes.



 Edit menu



Reverses the last edit or change to an object, except that you cannot undo changes to animations. 



Cancels the effect of your most recent Undo command.



Removes all components from the project. Use this command only if you want to discard all components of the 
scene except the project name.



Removes the selected components from the project.



Selects all objects in the scene if you have an object selected, or selects all lights in the scene if you have a light 
selected.



View menu



Uses the project window to display the scene as viewed through the camera lens. 
The Camera view is the view in which all rendering takes place, and it is the only perspective view of the scene.



Uses the project window to display the scene as viewed from above. 
Top view is a fixed, nonperspective view.



Uses the project window to display the scene as viewed from the side. 
Side view is a fixed, nonperspective view.



Uses the project window to display the scene as viewed from the front. 
Front view is a fixed, nonperspective view.



Displays all four views of the scene: Camera, Top, Side, and Front views.



Displays a dialog box to let you select which toolbars are displayed, and lets you choose other toolbar-related 
options, such as whether you want toolbar buttons to be large or small.



Shows or hides the catalog, which lets you add professionally developed objects, materials, lighting schemes, 
and animations to your scenes.



Shows or hides the Scene Explorer. The Scene Explorer lists all the resources that make up your scene (camera, 
objects, materials, animations, and lights) and shows their relationships.



Shows or hides the Animation Editor, which graphically illustrates the timing of each animation in your project. 
You can use the Animation Editor to slow down or speed up an animation, make an animation repeat, shift an 
animation forward or back in time, or reverse an animation's direction.



Tools menu



Starts the Text tool, which helps you create a text object by breaking the process into a few simple steps and 
displaying your text options in graphic form.



Starts the Extrusion tool, which lets you build 3D object by adding depth and beveling to 2D shapes. You can use 
any of several provided shapes, or you can open files of vector-based shapes (such as DRW and WMF files).



Displays the Camera Properties dialog box.



Sets the rendering quality to Good. With this setting, Simply3D renders the scene quickly but does not perform 
edge smoothing.



Sets the rendering quality to Better. With this setting, Simply3D renders the scene at moderate speed and some 
edge smoothing.



Sets the rendering quality to Best. With this setting, Simply3D renders more slowly but performs high-quality 
edge smoothing.



Turns shadow rendering on or off. When this setting is on and the conditions described below are met, objects in 
the scene cast shadows.

Simply3D shadows:
· Are visible only when you render the scene, and only if you activate shadows through the Tools/Render 

Settings menu item.
· Are cast only if the object is set to cast shadows.
· Are cast only by lights that are set to cast shadows.
· Fall only on objects that are set to receive shadows.
· Never show on the scene's background.



Produces a photo-realistic view of the scene. If the scene contains animations, the current animation frame is 
rendered.

To stop rendering, press the ESC key or click the Stop Rendering button .
Rendering takes lighting into account and shows shadows and reflections, provided you have activated them. 
Rendering also shows the effects of the texture maps, bump maps, and image reflection maps of all materials in the
scene.



Displays a dialog box that lets you change many Simply3D default settings to your own preferred settings.



Object menu



Displays the Animation editor and adds a "morph" animation bar for animated reshaping of the currently 
selected object.
You use the buttons on the Animation editor to apply Simply3D reshaping commands (such as Bend, Twist, and 
Extrude) to the animation bar at specific frames. When you play the animation, Simply3D automatically creates 
the intermediate shapes necessary to smooth the changes from shape to shape.



Creates a parent object for the currently selected object. Combining several objects under the same parent lets 
you move, rotate, and otherwise manipulate those objects as a single object.



Displays the currently selected 3D text in the Text tool so you can edit the text, its font, and other properties.



Displays the currently selected 3D text or extruded 2D object in the Extrusion tool so you can select a bevel type
and change other properties of the object.



Displays a wizard page that lets you select materials from a list. The material you select is applied to the 
currently selected object.



Displays a wizard page that lets you select an animation from a list. The animation you select is applied to the 
currently selected object.



Displays the Path page of the Text tool so you can choose a path for the letters of the currently selected 3D text.



Object/Modify Shape submenu items



Opens the Bend editor, which lets you reshape an object by bending its axis.



Opens the Twist editor, which lets you reshape an object by twisting selected points on its axis.



Opens the Envelope editor, which lets you reshape an object by distorting its bounding box.



Opens the Push-Pull editor, which lets you reshape an object by dragging specific points or groups of points on 
the object.



Opens the Extrusion editor, which lets you reshape an object by dragging specific points or groups of points on 
the object. This editor is similar to the Push-Pull editor, except that surrounding vertices are not affected.



Object > Modify Material submenu items



Displays the Surface tab of the Material editor so you can change the color and other properties of the material 
on the currently selected object.



Displays the Surface tab of the Material editor so you can change the transparency and other properties of the 
material on the currently selected object.



Displays the Surface tab of the Material editor so you can change the shininess and other properties of the 
material on the currently selected object.



Displays the Texture tab of the Material editor so you can change the texture image and other properties of the 
material on the currently selected object.



Displays the Bump tab of the Material editor so you can change the bump image and other properties of the 
material on the currently selected object.



Displays the Reflection tab of the Material editor so you can change the reflection and other properties of the 
material on the currently selected object.



Object > Modify Alignment submenu items



Aligns one object to the top of another object. Before using this feature, select the object to be moved, hold 
down the SHIFT key, and select the object that will remain stationary.



Aligns one object underneath anther object. Before using this feature, select the object to be moved, hold down 
the SHIFT key, and select the object that will remain stationary.



Aligns one object to the left of another object. To use this feature, select the object to be moved, hold down the 
SHIFT key, and select the object that will remain stationary.



Aligns one object to the right of another object. To use this feature, select the object to be moved, hold down the 
SHIFT key, and select the object that will remain stationary.



Aligns one object directly in front of another object. To use this feature, select the object to be moved, hold down
the SHIFT key, and select the object that will remain stationary.



Aligns one object directly behind another object. To use this feature, select the object to be moved, hold down 
the SHIFT key, and select the object that will remain stationary.



Object/Create submenu items



Adds a sphere to the scene. This is one of ten 3D primitives you can create.



Adds a cube to the scene. This is one of ten 3D primitives you can create.



Adds a cylinder to the scene. This is one of ten 3D primitives you can create.



Adds a cone to the scene. This is one of ten 3D primitives you can create.



Adds a torus (donut) to the scene. This is one of ten 3D primitives you can create.



Adds a wall to the scene. This is one of ten 3D primitives you can create.



Adds a box with rounded corners to the scene. This is one of ten 3D primitives you can create.



Adds a box with a hole in the middle to the scene. This is one of ten 3D primitives you can create.



Adds a vase to the scene. This is one of ten 3D primitives you can create.



Adds a floor to the scene. This is one of ten 3D primitives you can create.



Shades the selected object by averaging the color of each polygon with its surrounding polygons. The small flat 
surfaces that simulate curves are less apparent with smooth shading.
The Object Properties dialog box (available when you right-click an object) gives you more control over 
smoothing.



Specifies that you want the selected object to cast shadows.
Simply3D shadows:
· Are visible only when you render the scene, and only if you activate shadows through the Tools/Render 

Settings menu item.
· Are cast only if the object is set to cast shadows.
· Are cast only by lights that are set to cast shadows.
· Fall only on objects that are set to receive shadows.
· Never show on the scene's background.



Specifies that you want the selected object to receive shadows.
Simply3D shadows:
· Are visible only when you render the scene, and only if you activate shadows through the Tools/Render 

Settings menu item.
· Are cast only if the object is set to cast shadows.
· Are cast only by lights that are set to cast shadows.
· Fall only on objects that are set to receive shadows.
· Never show on the scene's background.



Removed Specifies that you want to render both sides of all the polygons that make up an object. Rendering the
backfaces takes longer, and it is not necessary with most closed, opaque objects.



Removed Object/Animate submenu items



Removed Spins the selected object 360 degrees around a vertical axis.
Additional animations are available in Simply3D catalogs.



Removed Tumbles the selected object 360 degrees around a horizontal axis.
Additional animations are available in Simply3D catalogs.



Removed Rotates the selected object 360 degrees clockwise.
Additional animations are available in Simply3D catalogs.



Removed Moves the selected object toward the camera along a wave-shaped path.
Additional animations are available in Simply3D catalogs.



Removed Moves the selected object toward the camera along a circular path.
Additional animations are available in Simply3D catalogs.



Removed Moves the selected object up, then down, and then back to its starting position.
Additional animations are available in Simply3D catalogs.



Removed Moves the selected object around a circular path. The object faces in one direction; it does not rotate 
as it moves.
Additional animations are available in Simply3D catalogs.



Displays a path editor that lets you reshape an animation's path by dragging points distributed along the path.



Displays the Animation Editor.



Lighting menu



Adds a new point light to the scene.



Activates the Move tool for the currently selected light. Same as clicking Move  in the Toolbox and then 
clicking the Move tool 
.



Displays the Light Properties editor for the currently selected light.



Camera menu



Activates the Move tool  for the camera.



Displays the Camera Properties dialog box, which lets you position and aim the camera by entering numeric 
values. You can also set the lens angle numerically.



Animation menu



Activates the Move tool for the currently selected animation. Same as clicking Move  in the Toolbox and then 
clicking the Move tool 
.



Displays a path editor that lets you reshape an animation's path by dragging points distributed along the path.



Displays the Animation Editor.



Window menu



Arranges all open windows so that the title bar of each scene is visible.



Stacks all open project windows so that a view of each project is visible.



Arranges all open project windows side-by-side so that a view of each project is visible.



Aligns all of the icons of minimized scenes in the Simply3D window.



This list gives you a quick way to display a specific scene when you have several scenes open.
Tip
· To cycle among multiple project windows, press CTRL+F6 repeatedly.



Help menu



Displays a list of help topics for Simply3D.



Describes Simply3D's compatibility with the Microsoft Office standard.



Displays the Simply3D Welcome screen. On this screen, you can examine Tips of the Day. You also can choose 
whether or not to display the Welcome screen when Simply3D starts.



Shows a screen with the version number, date, and other information about your copy of Simply3D.



CSH_Tool.DOC
This document contains the context-sensitive popup topics for all Simply3D tools and buttons whose commands 
are not already in CSH_MENU.DOC.



Scene Explorer buttons



Expands all categories in the Scene Explorer to list the scene's    resources (such as objects, materials, and 
animations) and to show their relationships within the scene.



Collapses all the category listings in the Scene Explorer.



Shows or hides the history of shaping commands applied to Simply3D primitive shapes and objects that you 
have created with the Profile Creation tool.



Shows or hides the pivot points of objects. When pivot points are visible, you can reposition them by dragging.



Standard Toolbar buttons
Note: Topics for some standard buttons, such as New and Copy, are in CSH_Menu.doc.



Stops rendering the scene. You can also press the ESC key to stop rendering.



Used with Wireframe viewing, Bounding Box determines whether you see a wireframe image or a bounding box 
as you manipulate the object. Although Bounding Box does not show the shape of the object until you finish 
dragging, it produces the fastest screen updates as you drag.
Notes
· You must select Wireframe view to select or deselect this option.
· You can select this as a default setting by clicking Options on the Tools menu.



Previews the object as a wireframe image while it is at rest and as either a wireframe or a bounding box as you 
drag it.

· To preview the object as a wireframe as you drag it, deselect the Bounding Box button .
· To preview the object as a bounding box as you drag it, select the Bounding Box button .
Tip
· You can select this as a default setting by clicking Options on the tools menu.



Previews objects as solid, shaded objects. Provides a more realistic picture of the object than wireframe or 
bounding-box preview, but it might not draw as quickly.
Tip
· You can select this as a default setting by clicking Options on the tools menu.



Displays a catalog browser (which lets you open a Simply3D catalog) and displays the catalog that you open.
Simply3D catalogs let you add professionally developed objects, materials, lighting schemes, and animations to 
your scenes.



Shows the current magnification setting and lets you select from several other settings. To change the setting, 
click the arrow next to the value and choose a setting from the menu. The view magnification does not affect 
how the scene is printed.



Lets you display help information about any button or menu item.
Click this button and then click the item for which you want help.



Toolbox buttons



The Pick button lets you select the camera, an object, a light, or an animation path, by clicking it in the project 
window.
· To select an object, click the object.
· To select the camera, click the background area.
Tip
· When you are using the Four Up view, the Pick button gives you a handy way to select how you preview 

animations. Click the view from which you want to see the animation, and then click the Play button  on 
the Animation Control toolbar.



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



The Move tools let you drag to move the selected resource (camera, objects, animation paths, or lights).
Tool Directions of Movement*

Left, right, up, down, and diagonal movement
Right and left movement only
Up and Down movement only
Forward and Backward movement only

* The view in which you drag determines how Simply3D interprets the drag. The directions here refer to the 
specific view's right, left, up, down, front, and back. If you want to limit movement to directions that are 
parallel to the "world" axes, drag in one of the fixed views (Top, Side, or Front).

Note 
· If you lock the camera's aiming point on a target object, the point remains locked on the target object when 

you move the object manually or move the camera in the Top, Side, or Front view.    However, the camera 
does not follow an animated target object. Also, if you want the aiming point to remain on the target object 
while you are using Camera view, you must use the Rotate tools instead of the Move tools. Note that the 
Rotate tools don't let you change the distance between the camera and its aiming point.



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



The Rotation tools let you drag to rotate the selected resource (camera, objects, animation paths, or lights). 
Rotating the camera or a light rotates the item around its aiming point.
Tool Directions of Rotation*

Right, left, up, down, and diagonal rotation
Right and left rotation only
Up and Down rotation only
Clockwise and counterclockwise rotation only

* The view in which you drag determines how Simply3D interprets the drag. The directions here refer to the 
specific view's right, left, up, down, clockwise and counterclockwise. If you want to limit rotation to axes that 
are parallel to the "world" axes, drag in one of the fixed views (Top, Side, or Front).



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



The Scale tools let you drag to resize objects, animation paths, and materials. They also let you adjust the 
camera's lens angle and the angles of a spotlight.

Tool
Effect on object 
or animation 
path

Effect on a material Effect on camera Effect on a 
spotlight

Resizes the item 
proportionally in all
three axes.

Resizes the material 
proportionally in X and 
Y axes.

Widens or narrows 
the camera's lens 
angle.

Adjusts hot spot 
and falloff together.

Scales the item 
only along its X 
(width) axis.

Scales the material 
along its X (width) axis.

Same as above Adjusts hot spot 
only.

Scales the item 
only along its Y 
(height) axis.

Scales the material 
along its Y (height) 
axis.

Same as above Adjusts falloff only.

Scales the item 
only along its Z 
(depth) axis.

Not applicable Same as above Not applicable

Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Centers the selected resource or resources in your scene.

Resource Effect of centering
Camera Moves the camera to a position that shows all the objects in the scene.
Objects Moves the selected objects to the center of Simply3D's world coordinate-system.
Lights Moves the selected lights to the camera's position and sets their aiming points at the center of 

the scene.



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Resets certain properties of the selected resource or resources in your scene.

Resource Effect of resetting
Camera Resets the original position, rotation, and lens angle of the camera.

Objects Resets the original position, rotation, and scale of the object. Does not cancel reshaping.

Animations Resets the original position, rotation, and scale of the animation.

Lights Resets the original position, rotation, and angle of the light.



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Lets you aim the camera or a selected light by dragging an aiming point in space.
This button is enabled only when you have selected the camera or a light.



Stub aliased to a real topic, above



Stub aliased to a real topic, above



Lets you indirectly position the selected light by clicking where you want its highlight to appear.
This button is enabled only when you have selected a light.



Displays buttons that let you add any of 10 primitive 3D shapes (such as a sphere or a cone), add a new light, or 
a create a new object using the Profile Creation tool.



Zooms in at the point where you click. To zoom out, press the CTRL key while you click.
Note
· You cannot use a Zoom tool in the Camera view.



Zooms out at the point where you click. To zoom in, press the CTRL key while you click.
Note
· You cannot use a Zoom tool in the Camera view.



Sets the magnification in the Top, Side, and Front views so that the camera and all objects are shown.
Note
· You cannot use a Zoom tool in the Camera view.



Turns the Autozoom feature on and off. This feature automatically adjusts the zoom to show the camera and all 
objects as you move items around in the scene.
Note
· You cannot use a Zoom tool in the Camera view.



Animation Control toolbar buttons



Shows the current frame number of the scene's animations.



Jumps to the scene's first animation frame. Enabled if you have animated at least one object in the scene.



Displays the previous frame of the scene's animations. Stops at Frame 1. Enabled if you have animated at least 
one object in the scene.



Stops an animation preview and displays the current frame number.



Previews the scene's animations, beginning at the current frame number. If you are at the ending frame, rewinds
to frame 1. Enabled only if you have animated at least one object in the scene.
Note
· To give you smooth animation when you are using the Four Up view, Simply3D previews the animation only in

the most recently used view. When the animation stops, the other three views are updated.



Displays the next frame in a scene's animations. Stops at the ending frame. Enabled if you have animated at 
least one object in the scene.



Displays the scene's ending animation frame. Enabled if you have animated at least one object in the scene.



Point-of-View toolbar buttons



These are all handled in CSH_Menu.doc, under the View menu.



FileOps.DOC
This document contains the file-operation topics for Simply3D help.



To open a project in Simply3D

1 On the Standard toolbar, click the Open button . The Open dialog box appears.
2 If necessary navigate to the folder that contains the project.
3 Click the file name, and then click Open.
Tips
· If you are opening a file that you have used recently, it will be listed at the bottom of the File menu. Click the 

file name to open it.
· Simply3D always opens S3D, E3D, and EYE files as projects. Other file types (such as Micrografx Draw DRW 

and Windows Metafile WMF) are opened as projects only if you have no project already open. If you have a 
project open, these files are imported into your scene as objects.

{button Related Topics,PI(`',`RT_To_open_a_project_in_Simply_3D')}



To start Simply3D 
To create a new, empty Simply3D project 
To create a new project using the Project Wizard 
To close the active project 
To print a scene from Simply3D 
To close Simply3D 

Saving Scenes in Different File Formats 



To open a Simply3D catalog
1 If the catalog window is not visible in Simply3D, click the catalog button on the Standard toolbar.
2 On the File menu, click Open Catalog. The Catalog browser appears, with a list of available catalogs. Each 

catalog's icon tells you whether the catalog is installed on the hard disk or located on CD-ROM.
3 Double-click the name of the catalog that you want. 
4 If Simply3D prompts you to insert the CD-ROM, insert the Simply3D CD-ROM, and click OK.
Tip
· If you have additional catalogs stored in a different location, click Browse and navigate to the location.

{button Related Topics,PI(`',`RT_To_open_a_Simply3D_catalog')}



Using a Simply3D Catalog 
Using the Scene Explorer    



Saving Scenes in Different File Formats
{button Tell me how...,PI(`',`HT_Saving_Scenes_in_Different_File_Formats')}

Normally, when you save a scene using the Save As command, you save it as a Simply3D project (S3D file). 
However, you can save the scene in any of several file formats. To select from a list, click the arrow  on the 
Save As dialog box.
Note
· You cannot convert the other formats back into an S3D file. To open the scene in Simply3D, you must save it 

as a Simply3D Project.

Type of File Comments
BMP bitmap image Windows bitmap file. Used by many Windows programs.
GIF bitmap image CompuServe Graphics Interchange Format. Displayed by 

many Web browsers.
JPG bitmap image JPEG (Joint Photographic Experts Group) file. Displayed by 

many Web browsers.
TGA bitmap image Targa bitmap file
TIF bitmap image Tagged Image File Format
WRL world file VRML (Virtual Reality Modeling Language) file for Web sites
Animated GIF Played automatically by some Web browsers
AVI animation Windows video file
FLC animation AutoDesk animation file
Sequential TGA Animated Targa format. Creates a series of individual TGA 

files. 

Bitmap Images
When saving a scene as a bitmap image, you specify the height and width in pixels, and you select the color 
depth (from 256 to 16.7 million colors). If you want to save a specific frame of an animated scene as a bitmap 
image, use the Animation Control toolbar to display that frame before using the Save as command.

Animation formats
The animation formats are listed only if you are saving a scene that contains one or more animations. When you 
click the Save button after selecting an animation format, a dialog box appears with options for that specific 
animation format.



To save a scene as a Simply3D file 
To save a scene as a bitmap file 
To save an animated scene as an AVI file 
To save an animated scene as an animated GIF file 
To save a scene as an interactive VRML "world" 



To save a scene as a Simply3D file

1 On the Standard toolbar, click the Save button . The Save As dialog box appears.
2 If you are saving in a folder that you have used recently, click the down arrow, and then click the folder 

name.
3 In the File Name box, type the name you want to use for your scene.
4 Click Save.
Tip
· After you have saved a scene, you can save changes to it quickly during a session by using the Save 

command on the File menu, or by pressing CTRL+S.

{button Related Topics,PI(`',`RT_To_save_a_new_scene_as_a_Simply_3D_file')}



To start Simply3D 
To create a new, empty Simply3D project 
To create a new project using the Project Wizard 
To close the active project 
To print a scene from Simply3D 
To close Simply3D 

Saving Scenes in Different File Formats 



To save a scene as a bitmap file
1 On the File menu, click Save As. The Save As dialog box appears.
2 In the Save as Type box, click the down arrow, and then click the type of bitmap file you want to save.
3 In the File Name box, type a name for the bitmap file.
Note
· If you plan to display the bitmap image on a Web page, save it as either a GIF or a JPG file.

{button Related Topics,PI(`',`RT_To_save_a_Simply_3D_scene_as_a_bitmap')}



To save a scene as a Simply3D file 
To save an animated scene as an animated GIF file 
To save a scene as an interactive VRML "world" 
To save an animated scene as an AVI file 

Saving Scenes in Different File Formats 



To save an animated scene as an AVI file
1 On the File menu, click Save As. The Save As dialog box appears.
2 In the Save as Type box, click the down arrow, and then click AVI File Format (.avi).
3 If you are saving in a folder that you have used before, click the down arrow, and then click the folder name.
4 In the File Name box, type a name for your animation.
Note
· Saving an animation may take a few minutes or several hours. A progress indicator shows the progress of the

save operation.

{button Related Topics,PI(`',`RT_To_save_an_animated_scene_as_an_AVI_file')}



To save a scene as a Simply3D file 
To save an animated scene as an animated GIF file 
To save a scene as an interactive VRML "world" 

Saving Scenes in Different File Formats 



To print a scene from Simply3D

1 On the Standard toolbar, click the Print button . The Print dialog box appears.
2 If you are not printing to your default printer, click the arrow in the Name box, and click the name of the 

printer you want to use.
3 If necessary, click Properties to set the properties of the selected printer.
4 Set the printing options, such as Rendering Quality and Image Size, and then click OK to print.
Notes
· Properties will vary from one printer to another.
· While a project is printing, a printer icon appears next to the clock on the Windows 95 taskbar. When this icon

disappears, your project has finished printing.

{button Related Topics,PI(`',`RT_To_print_a_scene_from_Simply_3D')}



To open a project in Simply3D 
To save a scene as a Simply3D file 
To close Simply3D 



To close the active project
On the project window, click the Close button 

. The active project closes.
Tip
· If you have several projects open, you can close all projects by quitting Simply3D. You are prompted to save 

any unsaved changes.

{button Related Topics,PI(`',`RT_To_close_the_active_project')}



To close Simply3D 

Saving Scenes in Different File Formats 



List of topics in this file

Saving Scenes in Different File Formats 

To open a project in Simply3D 
To save a scene as a Simply3D file 
To save a scene as a bitmap file 
To save an animated scene as an AVI file 
To print a scene from Simply3D 
To close the active project 



GetStart.DOC
This document contains miscellaneous topics for Simply3D help.



Parts of the Simply3D Window
{button Tell me how...,PI(`',`HT_Parts_of_the_Simply_3D_Window')}

Click each toolbar and window below to see a description.

{button Related Topics,PI(`',`RT_Parts_of_the_Simply_3D_Window')}



To start Simply3D 
To close Simply3D 
To create a new, empty Simply3D project 
To create a new project using the Project Wizard 



Building a Simply3D Scene 
Using the Scene Explorer 
Using a Simply3D Catalog 



Popup topics for the image “ProjectWindow.shg”



Standard toolbar

Provides buttons for performing common file and editing operations, rendering scenes, setting object-previewing 
options, and viewing the catalog and the Scene Explorer. 

While using Simply3D, you can get help for any button by clicking the Help button  and then clicking the 
button for which you want help.



Animation Control toolbar

Provides VCR-like buttons for previewing your scene's animations.

While using Simply3D, you can get help for any button by clicking the Help button  on the Simply3D Standard 
toolbar and then clicking the button for which you want help.



Point-of-View toolbar

Provides buttons for setting the point of view from which you view your scene and buttons for zooming the 
camera in and out.
The Camera point of view shows the scene as it would look throught the camera's viewfinder. The Top, Side, and 
Front points of view let you see and adjust positional relationships between objects.

While using Simply3D, you can get help for any button by clicking the Help button  on the Simply3D Standard 
toolbar and then clicking the button for which you want help.



Toolbox

Provides tools for manipulating the camera, objects, lights, and even the animations in your scene. Also has 
buttons for creating simple shapes (such as spheres and boxes), creating your own 3D text, and magnifying 
certain views.

While using Simply3D, you can get help for any button by clicking the Help button  on the Simply3D Standard 
toolbar and then clicking the button for which you want help.



Project window

The project window shows your scene in preview form as you work, and shows it in rendered form when you click
the Render button .

You can choose how you want to preview objects as you manipulate them, and you can choose different points of 
view for the project window, such as Camera, Top, Side, and Front views.



Scene Explorer

The Scene Explorer lists each resource (camera, object, material, light, and animation) in your scene. You can 
select a resource by clicking it, display its shortcut menu by right-clicking it, and even rename it.
You can also use the Scene Explorer to group objects, and you can drag an object to a new position in the Scene 
Explorer to change its relationship to other objects.

While using Simply3D, you can get Scene Explorer help by clicking the Help button  on the Simply3D Standard 
toolbar and then clicking in the Scene Explorer.



Simply3D Catalog
Simply3D catalogs contain collections of related 3D objects, materials, animations, and lighting schemes. The 
catalog shows each available resource as a small thumbnail picture. 
You add a catalog resource to your scene by dragging its picture from the catalog and dropping it on the scene or
the Scene Explorer.

While using Simply3D, you can get catalog help by clicking the Help button  on the Simply3D Standard toolbar 
and then clicking in the catalog.



End of popup topics for the image “Project Window.shg”



Building a Simply3D Scene
{button Tell me how...,PI(`',`HT_Building_a_Simply_3_D_Scene')}

Your 3D scenes will contain objects made of a specific materials, viewed through a camera, displayed or 
animated in three-dimensional perspective against a background, and illuminated by one or more lights.
Objects Simply3D objects are true three-dimensional shapes. For example, you can rotate an object to 

see all sides, as if you were turning it in your hand. Simply3D lets you move, rotate, scale 
(resize), and animate any object.
Simply3D lets you create 3D text objects and gives you several choices for populating a scene 
with other 3D objects. You can:
· Add an object from a Simply3D catalog
· Add a Simply3D primitive object from the Toolbox
· Extrude a 2D drawing into a 3D object
· Create an object by defining its top and side profiles
· Open an object from a 3D object file
Note: Do not open 2D DXF files. Simply3D can only use DXF files that contain 3D objects. 

Materials The materials covering your objects can be solid colors or bitmap images. Some of the Simply3D
catalog materials are designed to appear as a continuous texture. You can tile many copies of 
such a texture on an object without producing visible seams.
You can get material from a Simply3D catalog, paste a bitmap image from the Clipboard, or drag
a bitmap or animation file from the Windows Explorer. 

Camera The Simply3D camera can be moved, rotated, and aimed in any direction. You can adjust the 
angle of the camera's lens from extreme telephoto to a wide-angle, "fish-eye" lens.

Animation Simply3D includes many animation sequences for moving, rotating, and scaling objects. You can 
apply any animation to any object, including 3D text that you have created. Using the Scene 
Explorer, you can even group objects and animate them as one object.
You add animation to your objects by either dragging them from a catalog or selecting from a 
shortcut menu.

Background You can use a solid color or any bitmap image as the background of a scene. If you specify a 
background image, Simply3D automatically stretches or compresses it to fit the size of your 
scene.

Lights Lights produce highlights and shaded areas on the surfaces of the objects. Lights can also cast 
shadows of an object on other objects. You can move lights around in your scene    and change 
any light's color.
Lighting schemes are included in Simply3D catalogs, and you can copy and paste to create a 
duplicate of any light in the scene.

{button Related Topics,PI(`',`RT_Building_a_Simply_3_D_Scene')}
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Parts of the Simply3D Window 
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Adding 3D Objects to a Scene



To start Simply3D
1 Click the Start button on the Windows taskbar.
2 Point to Programs, point to Micrografx, and click Simply3D. Simply3D displays its startup screen (unless you 

have selected the option to bypass the screen).
3 Click one of the buttons on the startup screen.

- New starts with a new, empty Simply3D scene.
- Choose lets you browse to open an existing Simply3D scene.
- Most recently used files opens the scene listed in the drop-down list. To first select a different scene, 

click the down arrow .
- Project Wizard lets you create a new scene using Simply3D wizards.
- Next Tip displays Simply3D Tips of the Day.
- Close starts Simply3D with no project.

Tips
· You can also start Simply3D by double-clicking any Simply3D project (S3D) file.
· To bypass the startup screen each time you start Simply3D, click the "Don't display this startup screen again"

option. To restore the startup screen anytime after bypassing it, click Options on the Tools menu, Click the 
Display tab, and click Show Startup Screen.

{button Related Topics,PI(`',`RT_To_start_Simply_3D')}



To create a new, empty Simply3D project 
To create a new project using the Project Wizard 
To open a project in Simply3D 
To save a new scene as a Simply3D file 
To close the active project 
To close Simply3D 

Building a Simply3D Scene 



To close Simply3D
On the Simply3D window, click the Close button 

.
Note
· If you have any projects open with unsaved changes, you are prompted to save them.

{button Related Topics,PI(`',`RT_To_close_Simply_3D')}



To close the active project 



To create a new, empty Simply3D project
On the Standard toolbar, click the New button 

.
Tip
· If you want to use a wizard to create a new scene, click New Project on the File menu.

{button Related Topics,PI(`',`RT_To_create_a_new_empty_Simply_3D_project')}
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To create a new project using the Project Wizard
1 On the File menu, click New Project. The Project Wizard appears.
2 Click the button that you want to use for starting the new project.
Tip
· If you want to start with a new, empty scene, click the New button  on the Standard toolbar.

{button Related Topics,PI(`',`RT_To_create_a_new_project_using_a_wizard')}
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To set your options in Simply3D
1 On the Tools menu, click Options.
2 Click each tab and choose the settings that you want. The next time you start Simply3D, it will use your 

settings as the default settings.
Tip
· For information about the settings on each tab, click the Help button at the bottom of the tab.

{button Related Topics,PI(`',`RT_To_set_your_options_in_Simply_3D')}
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To set the aspect ratio of a scene
1 On the View menu, click Settings. The Aspect Ratio dialog box appears.
2 Click the arrow  to show the list of choices.
3 Click the predefined aspect ratio you want.

-or-
Click User Defined, and then enter the desired height and width ratio values in the boxes.
-or-
Click Any to choose a variable aspect ratio. You can change the height and width of the project window by 
dragging its borders.

{button Related Topics,PI(`',`RT_To_set_the_aspect_ratio_of_your_scene')}
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To show or hide specific toolbars
1 On the View menu, click Toolbars. The Toolbars dialog box appears.
2 Click to select the toolbars you want. Click to deselect the others.
Note
· The buttons on the Animation Control toolbar are disabled (dimmed) until you add at least one animation.

{button Related Topics,PI(`',`RT_To_show_or_hide_specific_toolbars')}



To show or hide the Scene Explorer 
To show or hide the catalog 
To show or hide the Animation Editor 
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To show or hide the catalog
On the Standard toolbar, click the Show/Hide catalog button 

.

{button Related Topics,PI(`',`RT_To_show_or_hide_the_catalog')}
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To expand or collapse the resource list
Click the Expand All button 

 or the Collapse All 
 button at the top of the Scene Explorer.

{button Related Topics,PI(`',`RT_To_show_or_hide_the_Scene_Explorer')}
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To show or hide the Scene Explorer
On the View menu, click Scene Explorer.

{button Related Topics,PI(`',`RT_To_show_or_hide_the_Scene_Explorer')}
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To copy an object, material, light, or animation
1 In the Scene Explorer, click the resource that you want to copy.

2 On the Standard toolbar, click the Copy button .

3 Click the Paste button . The copy appears at the same location as the original.

{button Related Topics,PI(`',`RT_To_copy_an_object_material_light_or_animation')}



To copy the entire scene to another project 



To rename resources in your scenes
1 In the Scene Explorer, click the name of the resource.
2 Pause briefly, and then click the name a second time. A cursor appears, showing that you can now edit the 

name.
3 Type the new name, and then press ENTER.
Tip
· When giving similar names to multiple items, copy the common portion of the names to the Clipboard. You 

can then paste the common portion into each new name instead of typing it.

{button Related Topics,PI(`',`RT_To_rename_resources_in_your_scenes')}
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To copy the entire scene to another project
1 At the top of the Scene Explorer, right-click View. A shortcut menu appears.
2 Click Copy.

3 Open the other project (or create a new one by clicking the New button ).
4 In the Scene Explorer of the new project, right-click View, and then click Paste.

{button Related Topics,PI(`',`RT_To_copy_the_entire_scene_to_another_project')}



To copy an object, material, light, or animation 



To cancel (undo) your most recent changes

On the Standard toolbar, click the Undo button 
.

Notes
· If you undo something and then change your mind, click the Redo button .

{button Related Topics,PI(`',`RT_To_cancel_undo_your_most_recent_changes')}



To remove an object-reshaping operation 
To edit an object-reshaping operation 
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This document contains the Internet topics for Simply3D help.



To save an animated scene as an animated GIF file
1 On the File menu, click Save As. The Save As dialog box appears.

2 Click the arrow  to display a list of file types, and then click Animated GIF File Format.
3 If necessary, type new values for the height and width of the animation.
4 If you want the background of the scene to be omitted, click the Transparent option.
5 In the Filename box, type the name you want for the animated GIF file.
6 Click the Save button. A dialog box appears.
7 Set the options for the GIF animation. For a description of the items, click the Help button.
8 Click OK to save the file. A dialog box reports the progress of the save operation until the file has been saved.
Tip
· Before saving any scene in an animation file-format, save it as a Simply3D (S3D) file. If you encounter a 

problem while saving the animation file, you can recover the scene.

{button Related Topics,PI(`',`RT_To_save_an_animated_scene_as_an_animated_GIF_file')}
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To save a scene as an interactive VRML "world"
1 On the File menu, click Save As. The Save As dialog box appears.

2 Click the arrow  to display a list of file types, and then click VRML File Format.
3 In the Filename box, type the name you want for the WRL (world) file.
4 Click the Save button. The VRML Export dialog box appears.
5 Set the options for the VRML file. For a description of the items, click the Help button.
6 Click OK to save the file.
Tips
· Before saving any scene in an animation file-format, save it as a Simply3D (S3D) file. If you encounter a 

problem while saving the animation file, you can recover the scene.
· If you want the animated objects in your scene to be animated in the VRML file, make sure you deselect the 

Export as VRML 1.0 option.

{button Related Topics,PI(`',`RT_To_save_a_scene_as_an_interactive_VRML_world')}
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Adding and Removing Lights
{button Tell me how...,PI(`',`HT_Adding_and_Removing_Lights')}

To light a scene, you may use multiple lights with any combination of light types and properties. However, each 
light increases rendering time, so use the minimum number of lights needed to create an effect.

Default lighting (2 point lights) Accent lighting (2 spotlights)

By default, Simply3D lights a scene using two point lights. A point light shines in all directions and is used for 
general illumination. For a different effect, you can change a point light to a spotlight which will focus light on a 
specific area.

Point light selected Spotlight selected

You can add more lights to your scene by copying and pasting existing lights,    and you can add a lighting 
scheme from the Simply3D catalog.
Note
· A scene must have at least one light source.

{button Related Topics,PI(`',`RT_Adding_and_Removing_Lights')}
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To add a light by copying and pasting
1 In the Scene Explorer, click any light to select it.

2 On the Standard toolbar, click the Copy button , and then click the Paste button 
.

3 If you are not in Four Up view, open the View menu, point to Point of View, and click Four Up.
4 Use a Move tool to move the newly pasted light away from the original.

{button Related Topics,PI(`',`RT_To_add_a_light_to_a_scene')}
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To add a lighting scheme from a catalog

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 In the left pane of the catalog, click Lights, and then use the scroll bar to view the available lighting schemes.
3 Drag the thumbnail image of the lighting scheme that you want, and drop it anyplace on your project window.

{button Related Topics,PI(`',`RT_To_add_a_light_source_from_a_Simply_3D_catalog')}
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To remove a light from a scene
1 In the Scene Explorer, click the light you want to remove.
2 Press the DELETE key.

{button Related Topics,PI(`',`RT_To_remove_a_light_from_a_scene')}
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To select a light
1 If you are not in Four Up view, open the View menu, point to Point of View, and click Four Up.
2 In the Scene Explorer, click the name of the light to select it.
Note
· If you don’t know the name of the light, click the light names one-by-one. The selected light is shown in 

yellow (highlighted).

{button Related Topics,PI(`',`RT_To_select_a_light')}



To select multiple lights 
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To select multiple lights
1 If you are not in Four Up view, open the View menu, point to Point of View, and click Four Up.
2 In the Scene Explorer, click one of the lights.
3 Press and hold the SHIFT key, and click each additional light.

{button Related Topics,PI(`',`RT_To_select_multiple_lights')}



To select a light 
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To change a light's color
1 In the Scene Explorer, right-click the name of the light. A shortcut menu appears.
2 Click Color to display the color picker.
3 Either click a color in the palette or click Define Custom Colors.
4 If you are defining a custom color, enter the values for the new color or drag the sliders. Then, click Add to 

Custom Colors
5 Click OK to apply the color to the light.

{button Related Topics,PI(`',`RT_To_change_a_light_s_color')}
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To change a light's brightness
1 In the Scene Explorer, right-click the name of the light, and then click Properties.
2 Drag the Brightness slider to change the light's brightness setting.

{button Related Topics,PI(`',`RT_To_change_a_light_s_brightness')}
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To change a light's type
1 In the Scene Explorer, right-click the name of the light. A shortcut menu appears.
2 Click either Point Light or Spotlight to select the type of light.

{button Related Topics,PI(`',`RT_To_change_a_light_s_type')}
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To move a light by dragging

 
1 If you are not in Four Up view, open the View menu, point to Point of View, and click Four Up.
2 In the Scene Explorer, click the name of the light to select it.

3 In the Toolbox, click the Move button , and then click the tool for the type of move.
4 Drag in any of the views to move the light.
Tip
· Objects moved in the Camera view are moved within the camera's coordinate system. If you want to move 

within the world coordinate system, drag in the Top, Side, or Front view.

{button Related Topics,PI(`',`RT_To_move_a_light_by_dragging')}
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To move a light to specific coordinates
1 In the Scene Explorer, right-click the name of the light.
2 On the shortcut menu, click Properties.
3 On the Light Properties dialog box, under Light Location, type the light's new X, Y, and Z coordinates.

{button Related Topics,PI(`',`RT_To_move_a_light_to_specific_coordinates')}
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Moving and Aiming Lights
{button Tell me how...,PI(`',`HT_Moving_and_Aiming_Lights')}

The direction in which a light is aimed is important only for spotlights. Although you can aim spotlights and point 
lights, point lights always shine in all directions.
Like the camera, each light moves around an aiming point. Because a light always aims directly at its aiming 
point, you can aim a light in any direction by repositioning the point.
A Highlight Object lets you click a specific point on an object where you want the selected light's highlight to 
appear. The tool automatically places the light and its aiming point in their required positions.

 
You can aim a light:
· By dragging its aiming point.
· By specifying 3D coordinates for its aiming point.
· By specifying a target object for the light.
· Indirectly by using the Highlight Object tool.

Aiming point with specified coordinates Aiming point set on an object

{button Related Topics,PI(`',`RT_Moving_and_Aiming_Lights')}
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To aim a light by placing its highlight on an object
1 In the Scene Explorer, click the light to select it.

2 In the Toolbox, click the Target button , and click the Highlight Object tool 

.
3 Click the point on the object where you want the highlight to be. Simply3D positions the light so that it 

produces the highlight.

{button Related Topics,PI(`',`RT_To_aim_a_light_by_placing_its_highlight_on_an_object')}
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To aim a light by dragging
1 On the View menu, point to Point of View, and then click Four Up to display all four views.
2 In the Scene Explorer, click the light to select it.

3 In the Toolbox, click the Target button , and click the Target tool 
.

4 In any view, drag to reposition the light's aiming point.

{button Related Topics,PI(`',`RT_To_aim_a_light_by_dragging')}
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To aim a light at specific coordinates
1 In the Scene Explorer, right-click the light. A shortcut menu appears.
2 Click Properties to display the Light Properties dialog box.
3 Under Target Location, type the X, Y, and Z coordinates of the aiming point. The light will point to those 

coordinates until you specify a target object or aim the light manually.

{button Related Topics,PI(`',`RT_To_aim_a_light_at_a_point_in_space')}
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To aim a light at a target object
1 In the Scene Explorer, right-click the name of the light to display its shortcut menu.
2 Click Properties. The Light Properties dialog box appears.

3 Click the arrow  next to Target Object to show the list of objects in the scene.
4 Click the name of the object that you want to use as the light’s target.
5 If you want the light to remain aimed at the target while you move or animate the object, click Lock Light on 

Target.

{button Related Topics,PI(`',`RT_To_lock_a_light_onto_a_specific_object')}
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To attach a light to an object
1 In the Scene Explorer, right-click the name of the light to display its shortcut menu.
2 Click Properties. The Light Properties dialog box appears.

3 Click the arrow  next to Attach Light to Object to show the list of objects in the scene.
4 Click the name of the object to which you want to attach the light. When you manipulate or animate the 

object, the attached light will move with it.

{button Related Topics,PI(`',`RT_To_attach_a_light_to_an_object')}
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To set the angles of a spotlight
1 If you are not in Four Up view, open the View menu, point to Point of View, and click Four Up.
2 In the Scene Explorer, click the name of the light to select it. (If you do not see angle lines for the light, right-

click the light, and then click Spot Light.)

3 In the Toolbox, click the Scale button , and then click the Scale All tool 
.

4 In any view, drag right or left to change the angle of the spotlight.
Tip
· To adjust a spotlight's "hot spot" (the smaller of the two angles shown in the nonperspective views) 

separately from its "soft angle," use the Scale X tool . To adjust the soft angle separately, use the Scale Y 
.

{button Related Topics,PI(`',`RT_To_set_the_angles_of_a_spotlight')}
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Setting a Light's Shadow Properties
{button Tell me how...,PI(`',`HT_Setting_Shadow_Properties')}

Using shadows adds an element of depth and realism to your rendered 3D scene. There are times, however, that
you may want to control whether shadows are rendered and how. Simply3D provides several options.
The method used to render shadows determines the visual effect.
· Ray Tracing. Ray-traced shadows have a harder edge than those produced by shadow mapping. Use ray 

tracing to produce realistic shadows for outdoor scenes and those that have high contrast (light to dark) 
lighting. Also, rendering shadows using ray tracing is the only way to produce realistic shadows for semi-
transparent objects.

· Shadow Mapping (default). Shadow-mapped shadows have a softer edge than ray-traced shadows. Use 
shadow mapping to produce realistic shadows for indoor scenes and those with soft lighting.

Ray-traced Shadows Shadow Mapped Shadows
(Shadow Map Size value of 50) 

{button Note on shadows,PI(`',`Popup_note_on_shadows')}

{button Related Topics,PI(`',`RT_Setting_Shadow_Properties')}



Popup note on Simply3D shadows



Simply3D shadows:
· Are visible only when you render the scene, and only if you activate shadows through the Tools/Render 

Settings menu item.
· Are cast only if the object is set to cast shadows.
· Are cast only by lights that are set to cast shadows.
· Fall only on objects that are set to receive shadows.
· Never show on the scene's background.
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To turn a light's shadows on or off
1 In the Scene Explorer, right-click the light. A shortcut menu appears.
2 Click Properties to display the Light Properties dialog box.
3 Click the Cast Shadows option to select it.
Note
· Simply3D shadows:

- Are visible only when you render the scene, and only if you activate shadows through the Tools/Render 
Settings menu item.

- Are cast only if the object is set to cast shadows.
- Are cast only by lights that are set to cast shadows.
- Fall only on objects that are set to receive shadows.
- Never show on the scene's background.

{button Related Topics,PI(`',`RT_To_turn_a_light_s_shadows_on_or_off')}
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To set shadow-rendering options
1 In the Scene Explorer, right-click the light. A shortcut menu appears.
2 Click Properties to display the Light Properties dialog box.
3 Verify that Cast Shadows is selected.
4 Click Ray Traced or Shadow Mapped, depending on the shadow rendering method you want. 
5 If you clicked Shadow Mapped, you can adjust the values for Shadow Bias and Shadow Map Size.
Note
· Shadow Bias controls the point at which an object begins to cast a shadow. In most cases, the default value 

of 0.100 produces a correctly rendered shadow. Values range from 0.000 through 1.000. At 0.000, an object 
will cast a shadow onto itself. At 1.000, an object will cast no shadows.

· Shadow Map Size controls the sharpness of shadow edges. Smaller values produce softer edges, and larger 
values produce sharper edges. The default value is 400.

{button Related Topics,PI(`',`RT_To_set_shadow_rendering_options')}
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To activate shadow rendering 

Setting a Light  ’  s Shadow Properties  



To rename a light
1 In the Scene Explorer, click the name of the light.
2 Pause briefly, and then click the name a second time. A cursor appears, showing that you can now edit the 

name.
3 Type the new name, and then press ENTER.

{button Related Topics,PI(`',`RT_To_rename_a_light')}



To add a light by copying and pasting 
To add a lighting scheme from a catalog 
To select a light 
To select multiple lights 

Adding and Removing Lights 
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Material.DOC
This document contains the material-related topics for Simply3D help.



To apply a catalog material to an object

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 Click the Materials tab, and use the scroll bar to view the available materials.
3 Drag the thumbnail image of the material from the catalog and drop it on the object.
Tips
· If the object is obscured or it intersects other objects, drop the material on the object's name in the Scene 

Explorer.
· If you are replacing one of several materials on an object, drop the new material on the old material's name 

in the Scene Explorer.

{button Related Topics,PI(`',`RT_To_apply_a_catalog_material_to_an_object')}



To copy a material 
To paste a Clipboard image to a material 
To assign a bitmap file as a material's image 
To edit a material's texture map with Picture Publisher 
To use a catalog material as the background 
To remove a material's texture map 
To rename a material 



To copy a material
1 In the Scene Explorer, right-click the material that you want to copy.
2 On the material's shortcut menu, click Copy.
3 In the Scene Explorer, right-click the material that you want to receive the copied material.
4 Click Paste.
Tip
· You can also use this method to copy a material from one Simply3D project to another.

{button Related Topics,PI(`',`RT_To_copy_a_material')}



To apply a catalog material to an object 
To rename a material 



To change the color of a material
1 In the Scene Explorer, click the "+" symbols to show the object's materials.
2 Right-click the specific material that you want to edit. A shortcut menu appears.
3 Click Color. The Material editor appears.
4 Under the sample of the material's color, click Change.
5 Either click a color in the palette or click Define Custom Colors.
6 If you are defining a custom color, enter the values for the new color or drag the sliders. Then, click Add to 

Custom Colors

{button Related Topics,PI(`',`RT_To_change_the_color_of_a_material')}



To lighten or darken a material 
To remove a material's texture map 
To reposition a material's texture map by dragging 
To reposition a material's texture map numerically 
To scale a material's texture map by dragging 
To scale a material's texture map numerically 



To reposition a material's texture map by dragging
1 In the Scene explorer, click the material to select it.

2 In the Toolbox, click the Move button , and click the applicable move tool (
, 
, or 
) for the direction that you want.

3 In the Camera view, point to the object and then drag to move the material.
Note
· Unlike with other dragging operations in Simply3D, the material moves only while the mouse pointer is on the

object.

{button Related Topics,PI(`',`RT_To_reposition_a_material_s_texture_map_by_dragging')}



To reposition a material's texture map numerically 
To scale a material's texture map by dragging 
To scale a material's texture map numerically 
To apply a catalog material to an object 
To edit a material's texture map with Picture Publisher 
To remove a material's texture map 



To reposition a material's texture map numerically
1 In the Scene explorer, right-click the material. The material's shortcut menu appears.
2 Click Texture. The Material editor appears, with the Texture tab selected.
3 Use the Map Position options and slider to reposition the material.
Note
· For descriptions of the Map Position options, click the Help button at the bottom of the Material editor.

{button Related Topics,PI(`',`RT_To_reposition_a_material_s_texture_map_numerically')}



To reposition a material's texture map by dragging 
To scale a material's texture map by dragging 
To scale a material's texture map numerically 
To apply a catalog material to an object 
To edit a material's texture map with Picture Publisher 
To remove a material's texture map 



To scale a material's texture map by dragging

 
1 In the Scene explorer, click the material to select it.

2 In the Toolbox, click the Scale button , and click the applicable scale tool (
, 
, or 
) for the type of scaling that you want.

3 In the Camera view, drag to scale the material.
Tip
· To tile, or repeat, the texture map across the material, drag toward the left.

{button Related Topics,PI(`',`RT_To_scale_a_material_s_texture_map_by_dragging')}



To scale a material's texture map numerically 
To reposition a material's texture map by dragging 
To reposition a material's texture map numerically 
To apply a catalog material to an object 
To edit a material's texture map with Picture Publisher 
To remove a material's texture map 



To scale a material's texture map numerically
1 In the Scene explorer, right-click the material. The material's shortcut menu appears.
2 Click Texture. The Material editor appears, with the Texture tab selected.
3 Use the Map Scale options and slider to reposition the material.
Tip
· To tile, or repeat, the texture map across the material, Set the Map Width and Height values to 0.5 or less.
Note
· For descriptions of the Map Scale options, click the Help button at the bottom of the Material editor.

{button Related Topics,PI(`',`RT_To_scale_a_material_s_texture_map_numerically')}



To scale a material's texture map by dragging 
To reposition a material's texture map by dragging 
To reposition a material's texture map numerically 
To apply a catalog material to an object 
To edit a material's texture map with Picture Publisher 
To remove a material's texture map 



To assign a bitmap file as a material's image
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Point to Texture, and then click Browse.
3 Navigate to the folder that contains the bitmap file, and double-click the filename. The bitmap image 

becomes the material's texture map.
Tip
· You can also drag a bitmap file directly from the Windows Explorer and drop it on a material in the Scene 

Explorer.

{button Related Topics,PI(`',`RT_To_assign_an_image_to_a_material_from_a_bitmap_file')}



To apply a catalog material to an object 
To edit a material's texture map with Picture Publisher 
To remove a material's texture map 



To paste a Clipboard image to a material
1 In the Scene explorer, right-click the material. A shortcut menu appears.

2 Point to Texture, and then click Paste .
Note
· Make sure that the program you use to copy the image to the Clipboard places the image there as a bitmap.

{button Related Topics,PI(`',`RT_To_paste_a_Clipboard_image_to_a_material')}



To apply a catalog material to an object 
To copy a material 
To assign a bitmap file as a material's image 
To edit a material's texture map with Picture Publisher 
To remove a material's texture map 



To lighten or darken a material
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Color. The Material editor appears.
3 Under the Material Color sample, click Change.
4 Click Define Custom Colors.
5 Drag the brightness slider up or down to lighten or darken the color. 
6 Click Add to Custom Colors

{button Related Topics,PI(`',`RT_To_lighten_or_darken_a_material')}



To change the color of a material 
To make a material shiny or dull 



To remove a material's texture map
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Texture to display the Texture tab of the Material editor.

3 Click the Cut button .

{button Related Topics,PI(`',`RT_To_remove_a_material_s_image_map')}



To paste a Clipboard image to a material 
To assign a bitmap file as a material's image 
To reposition a material's texture map by dragging 
To reposition a material's texture map numerically 
To scale a material's texture map by dragging 
To scale a material's texture map numerically 
To edit a material's texture map with Picture Publisher 



To make a material shiny or dull
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Shine to display the Surface tab of the Material editor.
3 Drag the Material Shininess slider and the Highlight Size slider.

{button Related Topics,PI(`',`RT_To_make_a_material_shiny_or_dull')}



To make a material reflect a specific image 
To remove a material's image reflection map 
To make a material reflect its surroundings 
To make a material semi-transparent 



To add texture to a material    by using a bump map
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Bump to display the Bump tab of the Material editor.

3 Under the Bump Map sample, click Open .
4 Navigate to the folder that contains the bitmap file you want to use as a bump map, and double-click the 

filename. The bitmap image becomes the material's bump map.
Tip
· If you are pasting a bitmap image from the Clipboard, click Paste  instead of Open in step 3.

{button Related Topics,PI(`',`RT_To_add_texture_to_a_material_by_using_a_bump_map')}



To adjust the height of a material's bump map 
To remove a material's bump map 
To reposition a material's texture map by dragging 
To reposition a material's texture map numerically 
To scale a material's texture map by dragging 
To scale a material's texture map numerically 



To adjust the height of a material's bump map
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Bump to display the Bump tab of the Material editor.
3 Drag the Bump Height slider. 

{button Related Topics,PI(`',`RT_To_adjust_the_height_of_a_material_s_bump_map')}



To add texture to a material    by using a bump map 
To remove a material's bump map 



To remove a material's bump map
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Bump to display the Bump tab of the Material editor.

3 Click the Cut button .

{button Related Topics,PI(`',`RT_To_remove_a_material_s_bump_map')}



To add texture to a material    by using a bump map 
To adjust the height of a material's bump map 



To make a material reflect a specific image
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Reflection to display the Reflection tab of the Material editor.

3 Under the Image Reflect sample, click Open .
4 Navigate to the folder that contains the bitmap file you want to use as a reflection.
5 Double-click the filename. The material will now reflect the image.
Tip
· If you are pasting a bitmap image from the Clipboard, click Paste  instead of Open in step 3.

{button Related Topics,PI(`',`RT_To_make_a_material_reflect_a_specific_image')}



To remove a material's image reflection map 
To make a material reflect its surroundings 
To make a material semi-transparent 



To remove a material's image reflection map
1 In the Scene explorer, right-click the material. A shortcut menu appears.
2 Click Reflection to display the Reflection tab of the Material editor.

3 Click the Cut button .

{button Related Topics,PI(`',`RT_To_remove_a_material_s_reflect_map')}



To make a material reflect a specific image 
To make a material reflect its surroundings 
To make a material semi-transparent 
To rename a material 



To make a material reflect its surroundings
1 In the Scene explorer, right-click the material to display its shortcut menu.
2 Click Reflection to display the Reflection tab of the Material editor.
3 Click Ray Trace Reflection to select it.
4 Drag the Ray Reflect slider or type a value between 0.000 and 1.000. Higher values produce brighter 

reflections.

{button Related Topics,PI(`',`RT_To_make_a_material_reflect_its_surroundings')}



To make a material reflect a specific image 
To remove a material's image reflection map 



To make a material semi-transparent
1 In the Scene Explorer, right-click the material. A shortcut menu appears.
2 Click Transparency to display the Transparency tab of the Material editor.
3 Drag the Transparency Level and Edge Transparency sliders.

{button Related Topics,PI(`',`RT_To_make_a_material_semi_transparent')}



To lighten or darken a material 
To change the color of a material 
To make a material shiny or dull 



To rename a material
1 In the Scene Explorer, click the name of the material.
2 Pause briefly, and then click the name a second time. A cursor appears, showing that you can now edit the 

name.
3 Type the new name, and then press ENTER.

{button Related Topics,PI(`',`RT_To_rename_a_material')}



To copy a material 
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Objects.DOC
This document contains the 3D object topics for Simply3D help.



 Adding 3D Objects to a Scene
{button Tell me how...,PI(`',`HT_Adding_3D_Objects_to_a_Scene')}

Besides letting you create your own 3D text, Simply3D gives you several choices for populating a scene with 
other 3D objects. You can:
· Add an object from a Simply3D catalog
· Add a Simply3D primitive object from the Toolbox
· Extrude a 2D drawing (such as a DRW, DSF, WMF, or CDR file) into a 3D object
· Open an object from a 3D object file
· Create an object by defining its top and side profiles

{button Related Topics,PI(`',`RT_Adding_3D_Objects_to_a_Scene')}



To add an object from a Simply3D catalog 
To add a Simply3D primitive object 
To extrude a 2D drawing into a 3D object 
To open an object from a 3D object file 
To create an object by defining its top and side profiles 



Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 
Reshaping a 3D Object 



To add an object from a Simply3D catalog

 
1 If the catalog is not visible, click the catalog button  on the Standard toolbar.
2 In the catalog, click Objects to display the available objects.
3 Double-click the object that you want. The object appears at the center of the scene.
Tip
· If you want to add the new object as a child of another object, drag it from the catalog and drop it on its 

parent object in the Scene Explorer.

{button Related Topics,PI(`',`RT_To_add_an_object_from_a_Simply_3D_catalog')}



To rename an object 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 



To add a Simply3D primitive object

In the Toolbox, click the Shapes button 
, and then click the button for the shape you want. The object appears in the center of the Simply3D world.

Tip
· If you manipulate the camera frequently, add a floor primitive  to serve as a visual reference. You can 

remove the floor before final rendering.

{button Related Topics,PI(`',`RT_To_create_a_Simply_3D_primitive_object')}



To remove an object from the scene 
To copy an object to another Simply3D project 
To rename an object 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 
Reshaping a 3D Object 



To extrude a 2D drawing into a 3D object
1 On the Tools menu, click Extrusion. The Extrusion Tool appears.
2 Do one of the following:

· To choose one of the displayed 2D shapes, click its thumbnail image.
· To paste a 2D drawing that you have copied to the Clipboard, click the large clipboard button.
· To import a 2D drawing file, click the large file-open button, navigate to the folder containing the drawing,

and double click the filename.
3 When the new 3D object appears in the preview box, click the Next button as necessary to assign a bevel 

type, extrusion depth, material, and animation to it.
Tips
· As an alternative method of importing a 2D drawing file, you can click Open on the File menu, navigate to the

folder containing the drawing, and double-click the filename. The drawing appears in the scene as an object, 
and its name (initially "extrusion") appears in the Scene Explorer. Right-click to assign a bevel type and 
extrusion depth, material, or animation.

· It's best to import 2D drawing files that contain a single shape. If you import a 2D file that contains multiple 
objects, it will be imported into Simply3D as a single object by default.    To manipulate different parts of the 
extrusion independently, right-click the "extrusion" object in the Scene Explorer, and click    "Separate 
Objects."

Notes
· You cannot extrude files that began as bitmap formats, such as BMP, GIF, or JPG.    Simply converting the 

bitmap to a supported extrusion format, like WMF, will not make it a 3D object.    Instead, the drawing must 
begin as a vector format, such as DRW or CDR. 

· You cannot extrude text included in a 2D drawing file. Instead, use the following procedure to import the non-
text portion of the drawing. Then, re-create the text portion using Simply3D's Text Tool.
1 On the File menu, click Open.
2 Browse to the 2D file and open it.
3 In the Scene Explorer, right click on the "Extrusion" object and click "Separate Objects."
4 Select the text object in the Scene Explorer and delete it.
5 Start the Text tool and re-create the text that you deleted.
6 Scale and position the text as desired in relation to the extruded drawing.

{button Related Topics,PI(`',`RT_To_extrude_a_2D_drawing_into_a_3D_object')}



To copy an object to another Simply3D project 
To remove an object from the scene 
To rename an object 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 



To open an object from a 3D object file
1 On the File menu, click Open. The Open dialog box appears.

2 Next to Files of Type, click the arrow , and then click the type of 3D file (such as OBJ, GED, or DXF) that 
contains the 3D object.

3 Navigate to the folder containing the file, click the filename, and then click Open.

{button Related Topics,PI(`',`RT_To_add_objects_from_a_3D_object_file')}



To copy an object to another Simply3D project 
To remove an object from the scene 
To rename an object 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 



To create an object by defining its top and side profiles
1 In the Toolbox, click the Shapes    button, and click Profile Creation. The Profile Creation tool appears.
2 In the Shapes Toolbar, Click the shape that you want to use as a starting shape.
3 Click Top Cap or Bottom Cap as necessary to remove or restore the object's caps.
4 In the Section group, set options for shaping the object cross-sections as viewed from the top (shown in the 

upper-left window).
- Type the number of section divisions that you want between each pair of section keys.
- Type the number of section Keys that you want to be able to manipulate.
- If you want reshaping to affect only one section at a time, click Separate Section.
- If you want to eliminate the curvature at the section keys, click Linear Section.

5 In the Profile group, set options for shaping the object as viewed from the side. (shown in the lower-left 
window)
- If you want to give an open object thickness, drag the Thickness slider.
- If you want to eliminate the curvature at the profile keys, click Linear Profile.
- Type the number of profile divisions that you want between each pair of profile keys.
- Type the number of profile Keys that you want to be able to manipulate.

6 On the Editor's toolbar, click the Pick button , and then point to the keys you want to edit. A rectangle 
appears around the key or keys to show that they have been selected.

7 On the Editor's toolbar, click the button for the type of shaping that you want to perform.
-  Pick¾Lets you move the key.
-  Edit Curve Linked¾Lets you shape the axis as a Bezier curve at the selected key. As you drag, the 

tangent for the selected key follows the mouse pointer.
-  Edit Curve Unlinked¾Similar to the previous tool, except that you can drag one half of the tangent 

without disturbing the other half.
8 Drag to shape. Use the right and bottom scroll bars as necessary to view your changes from different angles.
Tip
· For descriptions of all controls in the Profile Creation tool, click the Help button on the right-hand side of the 

tool.

{button Related Topics,PI(`',`RT_To_create_an_object_by_defining_its_top_and_side_profiles')}



Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 
Morphing an Object (Animated Reshaping) 
Applying a Catalog Deformation to an Object 



To align one object with another
1 Select the object to be moved.
2 Press and hold the SHIFT key, and click the object that will remain stationary. Both objects are now selected.
3 On the Object menu, point to Modify Alignment, and click the alignment option that you want. The first object

moves to align with the second object.

{button Related Topics,PI(`',`RT_To_align_one_object_with_another')}



To move an object to specific coordinates 
To rename an object 

Grouping and Ungrouping Objects 
Moving Objects by Dragging 



To select an object using the project window

 
1 In the Toolbox, click the Pick button . 
2 Click the object.    
Note
· In solid shaded preview, selected objects    in the project window are not highlighted. However, their names 

are highlighted in the Scene Explorer.

{button Related Topics,PI(`',`RT_To_select_an_object_using_the_project_window')}



To select an object using the Scene Explorer 
To select multiple objects using the project window 
To select multiple objects using the Scene Explorer 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Grouping and Ungrouping Objects 



To select an object using the Scene Explorer

 
Click the name of the object.    

Note
· In wireframe preview, selected objects are shown in yellow (highlighted). Although objects are not highlighted

in solid shaded view, the name of the selected object is highlighted in the Scene Explorer.

{button Related Topics,PI(`',`RT_To_select_an_object_using_the_Scene_Explorer')}



To select an object using the project window 
To select multiple objects using the project window 
To select multiple objects using the Scene Explorer 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 



To select multiple objects using the project window

1 In the Toolbox, click the Pick button . 
2 In the project window, click one of the objects.
3 Press and hold the SHIFT or CTRL key, and click each additional object.
Note
· You can group multiple objects under a parent object and then move, rotate, scale, and animate them all by 

moving, rotating, scaling, and animating the parent. However, you cannot change other object properties by 
selecting the parent; you must select the child object.

{button Related Topics,PI(`',`RT_To_select_multiple_objects_using_the_project_window')}



To select an object using the project window 
To select an object using the Scene Explorer 
To select multiple objects using the Scene Explorer 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Grouping and Ungrouping Objects 



To select multiple objects using the Scene Explorer
1 In the Scene Explorer, click one of the objects to select it.
2 Press and hold the SHIFT or CTRL key, and click each additional object.
Note
· You can group multiple objects under a parent object and then move, rotate, scale, and animate them all by 

moving, rotating, scaling, and animating the parent. However, you cannot change other object properties by 
selecting the parent; you must select the child object.

{button Related Topics,PI(`',`RT_To_select_multiple_objects_using_the_Scene_Explorer')}



To select an object using the project window 
To select an object using the Scene Explorer 
To select multiple objects using the project window 

Adding 3D Objects to a Scene 
Moving Objects by Dragging 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Grouping and Ungrouping Objects 



 Moving Objects by Dragging
{button Tell me how...,PI(`',`HT_Moving_Objects_by_Dragging')}

You can drag an object to a new position by selecting it and then choosing a tool from the Move button  in the
Toolbox. The Move tools let you drag objects along any two axes 

 or along a single axis 
    
    
. The specific axis depends on which view you use. 

Suppose you want to move a vase directly toward the front of a table.

You can move the vase in one axis by choosing one of the single-axis Move tools and dragging in the appropriate
nonperspective view (Top, Side, or Front). For example, you could use the Move Up/Down tool  in the Top view, 
because Up and Down in that view represent the back and front of the table. You could also use the Move 
Left/Right tool 

 in the Side view or the Move In/Out tool 
 in the Front view.

In this case, trying to move the vase forward by using the Move In/Out tool  in the Camera view has the wrong
effect. It moves the vase toward the camera, raising it off the table.

{button Related Topics,PI(`',`RT_Moving_Objects_by_Dragging')}



To move an object by dragging 
To move an object to specific coordinates 
To center an object in the scene 



Adding 3D Objects to a Scene 
Rotating Objects by Dragging 
Scaling Objects by Dragging 
Changing the Appearance of an Object's Surface 
Grouping and Ungrouping Objects 
Reshaping a 3D Object 



To move an object by dragging

 
1 In the Scene Explorer, click the object's name to select it.

2 In the Toolbox, click the Move button , and then click the tool for the type of movement you want.
3 In any of the view panes, drag to move the object.
Tip
· Objects moved in the Camera view are moved within the camera's coordinate system. If you want to move 

within the world coordinate system, drag in the Top, Side, or Front view.

{button Related Topics,PI(`',`RT_To_move_an_object_by_dragging')}



To move an object to specific coordinates 
To center an object in the scene 

Moving Objects by Dragging 



To move an object to specific coordinates
1 In the Scene Explorer, right-click the object's name to display its shortcut menu.
2 Click Properties to display the Object Properties dialog box.
3 Click the General tab.
4 In the Object Location group, type the X, Y, and Z coordinates of the new location.

{button Related Topics,PI(`',`RT_To_move_an_object_to_specific_coordinates')}



To move an object by dragging 
To center an object in the scene 
To align one object with another 

Moving Objects by Dragging 



Rotating Objects by Dragging
{button Tell me how...,PI(`',`HT_Rotating_Objects_by_Dragging')}

You can use the mouse to rotate an object around its pivot point by selecting it and then choosing a tool from the
Rotate button  in the Toolbox. The Rotate tools let you drag objects around any two axes 

 or around a single axis 
    
    
. The specific axis depends on which view you use.
 

Suppose you want to rotate a checkbook as it rests on a table.

You can rotate the checkbook in one axis by choosing one of the single-axis Rotate tools and dragging in the 
appropriate nonperspective view (Top, Side, or Front). For example, you could use the Rotate 
Clockwise/Counterclockwise tool  in the Top view, because clockwise and counterclockwise in that view 
suggest the type of rotation you want. You could also use the Rotate Left/Right tool 

 in the Side view or the Front view.

Because object rotation is always around the axes of the specific view, trying to rotate the checkbook by using 
the Rotate Left/Right tool  in the Camera view has the wrong effect. It rotates the checkbook to the camera's 
left and right instead of the table's left and right.

{button Related Topics,PI(`',`RT_Rotating_Objects_by_Dragging')}
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To rotate an object by dragging

 
1 In the Scene Explorer, click the object's name to select it.

2 In the Toolbox, click the Rotate button , and then click the tool for the type of rotation you want.
3 Drag in any view to rotate the object. The object rotates around its pivot point.
Tip
· Objects rotated in the Camera view are rotated according to the camera's coordinate system. For accurate 

rotation, drag in the Top, Side, or Front view. 

{button Related Topics,PI(`',`RT_To_rotate_an_object_by_dragging')}



To rotate an object to specific angles 
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To rotate an object to specific angles
1 In the Scene Explorer, right-click the object's name. A shortcut menu appears.
2 Click Properties to display the Object Properties dialog box.
3 In the Object Rotation group, type the new rotation angles, in degrees, for the object's X, Y, and Z axes.

{button Related Topics,PI(`',`RT_To_rotate_an_object_to_specific_angles')}



To rotate an object by dragging 
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Rotating Objects by Dragging 



To restore an object's original rotation
1 In the Scene Explorer, right-click the object's name to display its shortcut menu.
2 Click Properties to display the Object Properties dialog box.
3 In the Object Rotation group, type 0 (zero) for each rotation axis that you want to reset.

{button Related Topics,PI(`',`RT_To_restore_an_object_s_original_rotation')}
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To move an object's pivot point
1 If the object's resources are not visible in the Scene Explorer, click the + symbol next to the object's name.
2 If the object's pivot point is not listed as a resource, click the Show/Hide Pivot Points button  at the top of 

the Scene Explorer.
3 In the Scene Explorer, click the pivot point to select it. The pivot point's axes appear in the preview.

4 Click the Move button , and click the tool for the direction of movement you want.
5 Drag in any view to move the pivot point.
Tips
· Dragging a pivot point in the Camera view moves it according to the camera's coordinate system. For more 

accurate positioning, drag in the Top, Side, or Front view.
· If you want to rotate several objects around a single pivot point instead of around their separate pivot points, 

group the objects.

{button Related Topics,PI(`',`RT_To_move_an_objects_pivot_point')}
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To show or hide pivot points in the Scene Expolorer

Click the Show/Hide Pivot Points button 
 at the top of the Scene Explorer.

{button Related Topics,PI(`',`RT_To_show_or_hide_pivot_points_in_the_Scene_Expolorer')}



To move an object's pivot point 
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Scaling Objects by Dragging
{button Tell me how...,PI(`',`HT_Scaling_Objects_by_Dragging')}

You can use the mouse to resize an object by selecting it and then choosing a tool from the Scale button  in 
the Toolbox. The Scale tools let you shrink or expand objects proportionately 

 or along a single axis 
    
    
.
 

Unlike the Move and Rotate tools, scaling is always based on the object's axes, regardless of the view in which 
you drag.

Enlarged with Scale XYZ tool Enlarged with Scale X tool

Enlarged with Scale Y tool Enlarged with Scale Z tool

{button Related Topics,PI(`',`RT_Scaling_Objects_by_Dragging')}
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To scale an object by dragging

 
1 In the Scene Explorer, click the object's name to select it.

2 In the Toolbox, click the Scale button , and then click the tool for the type of scaling you want.
3 Drag in any view to scale the object.
Note
· Simply3D always scales an object according to the object's own coordinate system, regardless of the view in 

which you drag. For example, scaling a waste basket in the Y axis always makes it taller or shorter¾even if it 
is lying on its side.

{button Related Topics,PI(`',`RT_To_scale_an_object_by_dragging')}



To scale an object numerically 

Scaling Objects by Dragging 



To scale an object numerically
1 In the Scene Explorer, right-click the object's name to display its shortcut menu.
2 Click Properties to display the Object Properties dialog box.
3 In the Object Scale group, type a value for each scaling axis that you want to change.

{button Related Topics,PI(`',`RT_To_scale_an_object_numerically')}



To scale an object by dragging 

Scaling Objects by Dragging 



 To restore an object's original scale
1 In the Scene Explorer, right-click the object's name to display its shortcut menu.
2 Click Properties to display the Object Properties dialog box.
3 In the Object Scale group, type 0 (zero) for each scaling axis that you want to reset.

{button Related Topics,PI(`',`RT_To_restore_an_object_s_original_scale')}
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To restore an object's original rotation 
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To center an object in the scene
1 In the Scene Explorer, click the object's name to select it.

2 In the Toolbox, click the Center button .
Tip
· If the centered object is no longer in view of the camera, you can locate it by selecting Four Up view, clicking 

the Zoom button , and then clicking the Smart Zoom tool 
.

{button Related Topics,PI(`',`RT_To_center_an_object_in_the_scene')}



To restore an object's original rotation 
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Grouping and Ungrouping Objects
{button Tell me how...,PI(`',`HT_Grouping_and_Ungrouping_Objects')}

Grouping objects lets you select, move, rotate, scale, and animate them as if they were one object.
When you select the parent of a group and manipulate it, you automatically manipulate all of its child objects. 
However, when you select a child object and manipulate it, only the child object is affected.

Cylinders and cones grouped 
to form a pencil

Pencil objects (renamed) in the
Scene Explorer

You create groups within the Scene Explorer, using one of two methods. You can:
· Make an object a "child" of another object by dropping it on the other object. This method works for simple 

cases, but it does not let you manipulate the parent object separately from the child.
· Create a parent for one of the objects, and then drag the other objects to the new parent. This method, 

shown in the illustration, lets you manipulate any member of the group without affecting the other members. 
A parent created in this way is not visible in the project window; you can select it only by clicking it in the 
Scene Explorer. However, once you have selected the parent you can manipulate it just as any other object.
You    can move, rotate, scale, and animate objects grouped in this way by moving, rotating, scaling, and 
animating the parent. However, you cannot change other object properties by selecting the parent; you must 
select the child object.

Tip
· You can put together complex animations by creating a parent for a parent and assigning a different 

animation to each parent. You could use this technique, for example, to create a text message in which each 
letter tumbles end-over-end as the message orbits a globe.

{button Related Topics,PI(`',`RT_Grouping_and_Ungrouping_Objects')}
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To make one object a child of another object 
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To make one object a child of another object
1 In the Scene Explorer, click the object that will become the child.
2 Drag the child to the object that will become the parent and drop it. One object is now a child of another 

object. 
Note
· With this method of grouping, you cannot move, rotate, scale, or animate the parent object without also 

changing the child. As an alternative, you could group the objects differently by creating a parent for one of 
the objects and then dragging the other object to the new parent. This method lets you manipulate one 
member of the group or change its properties without affecting the other member.

{button Related Topics,PI(`',`RT_To_make_one_object_a_child_of_another_object')}



To group multiple objects 
To separate an object from a group 
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To group multiple objects
1 In the Scene Explorer, right-click one of the objects. A shortcut menu appears.
2 Click Create Parent. Simply3D creates a new object as the parent and attaches the original object as its child. 

The parent object is visible only in the Scene Explorer.
3 Drag the other objects and drop them on the new parent object. They become children of the parent object.
Note
· You can move, rotate, scale, and animate objects grouped in this way by moving, rotating, scaling, and 

animating the parent. However, you cannot change other object properties by selecting the parent; you must 
select the child object.

{button Related Topics,PI(`',`RT_To_group_multiple_objects')}
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To separate an object from a group
1 In the Scene Explorer, click the object's name to select it.
2 Drag the object, and drop it on the View (at the top of the Scene Explorer).

{button Related Topics,PI(`',`RT_To_separate_an_object_from_a_group')}
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Changing the Appearance of an Object's Surface
{button Tell me how...,PI(`',`HT_Changing_the_Appearance_of_an_Object_s_Surface')}

Besides setting the properties of individual materials that cover an object, you can set object properties that 
have a universal effect on all of the object's materials.

Smoothing Options
Without smoothing, the individual polygons that form the surface of the object are visible as flat surfaces. 
Smoothing makes the surface appear rounded. You can choose to apply smoothing only to angles equal to or less
than a specific angle. You can also choose Material Crease to make smoothing occur only for adjacent polygons 
covered with the same material.

Image-Mapping Options

Simple image

Each material on an object can have as many as three images: a 
texture map, a bump map, and an image reflection map. Mapping 
options let you change the way Simply3D applies these images to the 
object. You can position the maps, scale them, and cover the object 
with them in a variety of ways.

Unfold Spherical Cylindrical

Tiled (with scale -.76) Orthographic By Polygon

You can blur the boundaries between colors in all the images, and you can further blur the image reflection 
maps. If your materials use Bump Maps, increasing the Bump Height produces higher bumps and deeper valleys.
Using a negative value for the Bump Height reverses the bumps and valleys.

Bump Map Bump height set to 1 Bump height set to -1



Tip
· For descriptions of the object properties, click the Help button on each tab of the Object Properties dialog 

box.

{button Related Topics,PI(`',`RT_Changing_the_Appearance_of_an_Object_s_Surface')}
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To select how materials are mapped to an object
1 In the Scene Explorer, right-click the object's name to display its shortcut menu.
2 Click Properties to display the Object Properties dialog box.
3 Click the Mapping tab, and then set the mapping options.
Note
· The mapping options affect all materials applied to the object.

{button Related Topics,PI(`',`RT_To_select_how_materials_are_mapped_to_an_object')}
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To smooth an object
1 In the Scene Explorer, click the object to select it.
2 On the Object menu, click Smoothing.
Note
· In wireframe preview, the object will appear the same. When you render the scene, the object will be smooth.

{button Related Topics,PI(`',`RT_To_smooth_an_object')}
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To smooth multiple objects
1 In the Scene Explorer, click one of the objects to select it.
2 Press and hold the SHIFT key, and click each additional object.
3 On the Object menu, click Smoothing.
Note
· In wireframe preview, the objects will appear the same. When you render the scene, the objects will be 

smooth.

{button Related Topics,PI(`',`RT_To_smooth_multiple_objects')}
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To show or hide an object
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Click Hide to show or hide the object.
Tip
· Hidden objects are never hidden in the Scene Explorer. 

{button Related Topics,PI(`',`RT_To_show_or_hide_an_object')}
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To copy an object to another Simply3D project
1 In the Scene Explorer, click the object's name to select it.
2 On the Edit menu, click Copy.
3 On the Window menu, click the name of the project that will receive the object. Its project window is 

activated.
4 On the Edit menu, click Paste.

{button Related Topics,PI(`',`RT_To_copy_an_object_to_another_Simply_3D_project')}
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To remove an object from the scene
1 In the Scene Explorer, click the object's name to select it.
2 Press the DELETE key.
Tip
· If you want to move the object to another Simply3D project, cut it to the Clipboard and then paste it into the 

other project.

{button Related Topics,PI(`',`RT_To_remove_an_object_from_the_scene')}
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To prevent an object from casting a shadow
1 In the Scene Explorer, right-click the object. A shortcut menu appears.
2 Click Properties. The Object Properties dialog box appears.
3 On the General tab, click the Cast Shadows option to deselect it.
{button Note on shadows,PI(`',`Popup_note_on_shadows')}

{button Related Topics,PI(`',`RT_To_make_an_object_cast_a_shadow')}
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To make an object receive shadows
1 In the Scene Explorer, right-click the object. A shortcut menu appears.
2 Click Properties. The Object Properties dialog box appears.
3 On the General tab, click the Receive Shadows option to select it.
{button Note on shadows,PI(`',`Popup_note_on_shadows')}

{button Related Topics,PI(`',`RT_To_make_an_object_receive_shadows')}
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To rename an object
1 In the Scene Explorer, click the name of the object.
2 Pause briefly, and then click the name a second time. A cursor appears, showing that you can now edit the 

name.
3 Type the new name, and then press ENTER.
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To edit a rendered scene in Picture Publisher

1 On the Standard toolbar, click the Render button  to Render the scene.

2 Click the Copy button  to copy the scene to the Clipboard.
3 In Picture Publisher, open the Edit menu, and click Paste As New Image.
Note
· Picture Publisher receives a two-dimensional "snapshot" of the rendered scene. After editing the image in 

Picture Publisher, you can use it in Simply3D only as a background image, texture map, bump map, or image 
reflection map.

{button Related Topics,PI(`',`RT_To_edit_a_rendered_image_in_Picture_Publisher')}



To edit a material's texture map with Picture Publisher 
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To edit a material's texture map with Picture Publisher
1 In the Scene Explorer, right-click the material. A shortcut menu appears.
2 Click Texture to display the Texture tab of the Material editor.

3 Under the Texture Map, click Copy  to copy the image to the Clipboard.
4 Start Picture Publisher. On the Edit menu, click Paste As New Image.

5 When you finish editing the image in Picture Publisher, click the Copy button  on Picture Publisher's 
Standard toolbar.

6 In Simply3D, click Paste  under the Texture Map, similar to step 3.

{button Related Topics,PI(`',`RT_To_edit_a_material_s_image_map_with_Picture_Publisher')}
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To render a scene

 
On the Standard toolbar, click the Render button 

. The scene is rendered according to the current rendering settings (on the Tools menu). Your scene must have at
least one object.

Tip
· To stop rendering a scene, you can either press the ESC key or click the Stop Rendering button  on the 

Standard toolbar.

{button Related Topics,PI(`',`RT_To_render_a_scene')}
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To set the rendering quality

On the Tools menu, point to Render Settings, and then click Good, Better, or Best.
Tip
· To change the specific rendering options for Good, Better, and Best, click Options on the Tools menu, and 

click the Rendering tab.

{button Related Topics,PI(`',`RT_To_set_the_rendering_quality')}
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To activate shadow rendering

On the Tools menu, point to Render Settings, and then click Shadows.
{button Note on shadows,PI(`',`Popup_note_on_shadows')}

{button Related Topics,PI(`',`RT_To_activate_shadow_rendering')}
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To stop rendering

 
On the Standard toolbar, click the Stop Rendering button 

.

{button Related Topics,PI(`',`RT_To_stop_rendering')}
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To render the backfaces of an object
1 In the Scene Explorer, right-click the object.
2 Click Properties.
3 On the General tab, click Render Backface.

{button Related Topics,PI(`',`RT_To_render_the_backfaces_of_selected_objects')}
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Reshaping a 3D Object
{button Tell me how...,PI(`',`HT_Reshaping_a_3D_Object')}

Reshape Tools
Simply3D gives you five powerful editing tools for reshaping objects. You can choose to reshape objects in-place 
(while working in the Camera, Top, Side, and Front views) or to use each tool's specialized window for reshaping.
· The Bend editor lets you bend, stretch, and compress an object's main axis.
· The Twist editor lets you twist an object's main axis.
· The Envelope editor lets you reshape a 3D object indirectly by distorting its envelope, or box-shaped 

container.
· The Push/Pull editor lets you reshape an object by dragging a selection rectangle around its vertices and 

manipulating the vertices as a group. You can move, rotate, and scale the vertices, and you can deform the 
object as if it were elastic.

· The Extrusion editor is similar to the Push-Pull editor, except that surrounding vertices are not affected.

Reshaped with the Bend editor Reshaped with the Twist editor

Reshaped with the Envelope editor Reshaped with the Push/Pull editor

Reshaped with the Extrusion editor

All reshaping operations that you perform on an object are stored in the object's Command Stack. You can use 
the Command Stack to remove or edit any of your reshaping operations.

Preview and Acceleration Options

If you are not using the Edit In-place option, you can right click in the preview window of any editor to display a 
shortcut menu for setting the editor's preview and acceleration options.    
Solid Shaded Previews the object as a solid, shaded image instead of as a wireframe.
Draw Backface Polygons This allows you to view all the polygons of an object while in wireframe view.    This 

option is only available when not using Direct3D or OpenGL acceleration.
If you have turned on the Edit In-place option, you can only set the preview and acceleration options by click ing 
Options on the Tools menu and then clicking the Acceleration tab.
Note



· You can use the Profile Creation tool to reshape objects that you created using that tool. However, you cannot
use the features of the Profile Creation tool to reshape any of the standard 3D primitives, Simply3D catalog 
objects, or objects imported from other formats.

{button Related Topics,PI(`',`RT_Reshaping_a_3D_Object')}
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Morphing an Object (Animated Reshaping)
{button Tell me how...,PI(`',`HT_Morphing_an_Object_Animated_Reshaping')}

Simply3D 3 lets you use the five reshaping editors (Bend, Twist, Envelope, Push/Pull, and Extrusion) to animate 
objects. You use the editors to shape the object at specific "key" animation frames, and Simply3D creates 
smooth transitions from each key frame to the next. You decide which frames to use as key frames. At each key 
frame, you can use the reshaping editors in any combination.
Here's how Simply3D morphing works:
First, you use the object's shortcut menu to create a Morph animation bar for the object in the Animation editor. 
You can drag the starting and ending points of the bar, just as you can for other types of animations.

Next, you use the Animation editor's Add Morph Key button  to add morph keys to the animation bar at the 
frames where you will reshape the object. You can add, delete, and move morph keys to different frames on the 
animation bar whenever you like.

Finally, you use the Edit Morph Key button  to display the Reshaping editors. You reshape the object for the 
selected morph key frame and then repeat the process for the other keys. Simply3D smoothes the transitions when 
you preview or save the animation.

Notes
· You can morph any object, including objects with animated materials.
· You can apply both morph animation and catalog animation to an object.
· You cannot morph from one object to another or from one material to another.

{button Related Topics,PI(`',`RT_Morphing_an_Object_Animated_Reshaping')}



To morph an object 
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To morph an object

1 If the catalog is displayed, click the Catalog button  to hide it and make room for the Animation editor.
2 In the Scene Explorer, right-click the object that you want to morph. The object's shortcut menu appears.
3 Click Create Morph Animation. Simply3D displays the Animation editor and adds a Morph animation bar for 

the object.

4 If you wish, click the Add Morph Key button , and click the animation bar at each frame where you plan to 
reshape.

5 Click the Edit Morph Key button , and click the morph key at which you want to reshape the object.
6 Use the reshaping editor or editors of your choice to reshape the object.
7 Repeat steps 5 and 6 for the other key frames.

{button Related Topics,PI(`',`RT_To_morph_an_object_animated_reshaping')}
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Applying a Catalog Deformation to an Object
{button Tell me how...,PI(`',`HT_Applying_a_Catalog_Deformation_to_an_Object')}

Simply3D 3 catalogs include some useful distortions that you can apply to objects. Some of these deformations 
are still, or static; others are animated. 

Original Object    + Catalog Deformation = Deformed Object

Note
· Still catalog deformations that you add to objects are not listed in the Scene Explorer. You can only remove a 

still catalog deformation from an object by using the Undo command (on the Edit menu) before you have 
performed any other actions that you want to keep. Animated catalog deformations are added in the Scene 
Explorer as Effects, so you can remove them from the object.

{button Related Topics,PI(`',`RT_Applying_a_Catalog_Deformation_to_an_Object')}



 To apply a still deformation to an object 
To apply an animated deformation to an object 
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To apply a still deformation to an object

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 In the catalog, click the Deformations tab.
3 Click the small tab labeled Still to display thumbnails of the available static deformations.
4 Drag the deformation that you want, and drop it on the object.
Note
· Still catalog deformations that you add to objects are not listed in the Scene Explorer. You can only remove a 

still catalog deformation from an object by using the Undo command (on the Edit menu) before you have 
performed any other actions that you want to keep.

{button Related Topics,PI(`',`RT_To_apply_a_still_deformation_to_an_object')}
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To apply an animated deformation to an object

1 If the catalog is not displayed, click the Catalog button  on the Standard toolbar.
2 In the catalog, click the Deformations tab.
3 Click the small tab labeled Animated to display thumbnails of the animated deformations.
4 Drag the deformation that you want, and drop it on the object.
Tips
· You can see a sample of each animation in the catalog by pausing the pointer on the animation's thumbnail.
· Animated catalog deformations are added in the Scene Explorer as Effects, so you can remove them from the

object.

{button Related Topics,PI(`',`RT_To_apply_a_still_deformation_to_an_object')}
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To reshape an object by bending its axis
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Point to Modify Shape, and then click Bend. The Bend editor appears and opens the object for reshaping. The 

object's axis is shown in red, and two or more control points (points that you can manipulate) are shown in 
blue.

3 If necessary, adjust the number of control points.
4 Click the tool for the type of bending you want to perform.
5 Point to the control point at which you want to reshape. The control point becomes highlighted.
6 Drag to reshape. Use the right and bottom scroll bars as necessary to change the effect of a tool or to view 

your changes from different angles.
Tip
· For descriptions of the bend tools, click the Help button at the bottom of the editor.

{button Related Topics,PI(`',`RT_To_reshape_an_object_by_bending_its_axis')}
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To reshape an object by twisting its axis
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Point to Modify Shape, and then click Twist. The Twist editor appears and opens the object for reshaping. The 

object's axis is shown in red, and two or more control points (points that you can manipulate) are shown in 
blue.

3 If necessary, adjust the number of control points.
4 Point to the control point around which you want to twist. The control point becomes highlighted.
5 Drag to reshape. Use the right and bottom scroll bars as necessary to change the effect of a tool or to view 

your changes from different angles.

{button Related Topics,PI(`',`RT_To_reshape_an_object_by_bending_its_axis')}
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To reshape an object by deforming its envelope
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Point to Modify Shape, and then click Envelope. The Envelope Editor appears and opens the object for 

reshaping. The object's envelope is shown in red.
3 If necessary, adjust the X, Y, and Z resolution of the envelope. To see the Z resolution, you can move the right

and bottom scroll bars slightly off center.
4 Drag a selection rectangle around the envelope vertices that you want to manipulate. The included vertices 

become highlighted.
5 Click the tool for the type of envelope reshaping you want to perform.
6 Drag to reshape. Use the right and bottom scroll bars as necessary to change the effect of a tool or to view 

your changes from different angles.
Tip
· For descriptions of the envelope-reshaping tools, click the Help button at the bottom of the editor.

{button Related Topics,PI(`',`RT_To_reshape_an_object_by_deforming_its_envelope')}
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To reshape an object using the push-pull editor
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Point to Modify Shape, and then click Push-Pull. The Push-Pull editor appears and opens the object for 

reshaping.

3 If you want elastic effects, click the Smooth button . If you don't want elastic effects, click the Crisp button
.

4 Drag a selection rectangle around the object vertices that you want to manipulate. The included vertices 
become highlighted. If you have selected elastic effects, a sphere representing the area of influence also 
appears.

5 If you are using elastic effects, click the Area button , and drag to resize the sphere. You can also drag the 
Slack slider to make the object more or less malleable.

6 Click the tool for the type of reshaping you want to perform.
7 Drag to reshape. Use the right and bottom scroll bars as necessary to change the effect of a tool or to view 

your changes from different angles.
Tip
· For descriptions of the push-pull reshaping tools, click the Help button at the bottom of the editor.

{button Related Topics,PI(`',`RT_To_reshape_an_object_using_the_push_pull_editor')}
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To reshape an object using the extrusion editor
1 In the Scene Explorer, right-click the object to display its shortcut menu.
2 Point to Modify Shape, and then click Extrude. The Extrusion editor appears and opens the object for 

reshaping.
3 Drag a selection rectangle around the object vertices that you want to manipulate. The included vertices 

become highlighted. 
4 Click the tool for the type of reshaping you want to perform.
5 Drag to reshape. Use the right and bottom scroll bars as necessary to change the effect of a tool or to view 

your changes from different angles.
Tip
· For descriptions of the extrusion reshaping tools, click the Help button at the bottom of the editor.

{button Related Topics,PI(`',`RT_To_reshape_an_object_using_the_extrusion_editor')}
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To reshape an object created with the Profile Creation tool
Note
· You can use this method only on objects that you create using the Profile Creation tool. You cannot use the 

features of the Profile Creation tool to reshape any of the standard 3D primitives, Simply3D catalog objects, 
or objects imported from other formats.

1 If command stacks are not visible in the Scene Explorer, click the Show/Hide Command Stacks button at the 
top of the Scene Explorer.

2 Double-click the Create command in the object's command stack. The Profile Creation tool appears and 
opens the object with its initial shape settings.

3 Click Top Cap or Bottom Cap as necessary to remove or restore the object's caps.
4 In the Section group, set options for reshaping the object cross-sections as viewed from the top (shown in the

upper-left window).
- Type the number of section divisions that you want between each pair of section keys.
- Type the number of section Keys that you want to be able to manipulate.
- If you want reshaping to affect only one section at a time, click Separate Section.
- If you want to eliminate the curvature at the section keys, click Linear Section.

5 In the Profile group, set options for reshaping the object as viewed from the side. (shown in the lower-left 
window)
- If you want to give an open object thickness, drag the Thickness slider.
- If you want to eliminate the curvature at the profile keys, click Linear Profile.
- Type the number of profile divisions that you want between each pair of profile keys.
- Type the number of profile Keys that you want to be able to manipulate.

6 On the Editor's toolbar, click the Pick button , and then point to the keys you want to edit. A rectangle 
appears around the key or keys to show that they have been selected.

7 On the Editor's toolbar, click the button for the type of reshaping that you want to perform.
-  Pick¾Lets you move the key.
-  Edit Curve Linked¾Lets you reshape the axis as a Bezier curve at the selected key. As you drag, the 

tangent for the selected key follows the mouse pointer.
-  Edit Curve Unlinked¾Similar to the previous tool, except that you can drag one half of the tangent 

without disturbing the other half.
8 Drag to reshape. Use the right and bottom scroll bars as necessary to view your changes from different 

angles.
Tip
· For descriptions of all controls in the Profile Creation tool, click the Help button on the right-hand side of the 

tool.

{button Related Topics,PI(`',`RT_To_reshape_an_object_by_changing_its_top_and_side_profiles')}
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To remove an object-reshaping operation

1 In the Scene Explorer, click the Show/Hide Command Stack button .
2 Click the + symbol next to the object's Command Stack icon.
3 Click the specific reshape operation, and press DELETE. 
Note
· You cannot delete the object's Create command.

{button Related Topics,PI(`',`RT_To_remove_an_object_reshaping_operation')}



To cancel (undo) your most recent changes 
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To edit an object-reshaping operation

1 In the Scene Explorer, click the Show/Hide Command Stack button .
2 Click the + symbol next to the object's Command Stack icon.
3 Double-click the specific reshape operation. Simply3D opens the object in the reshaping editor that you used,

with the object shaped as it was when you reshaped it originally.
4 Use the editor's tools to reshape the object.
5 Click OK. The remaining reshaping operations, if any, are applied to the newly edited object.

{button Related Topics,PI(`',`RT_To_edit_an_object_reshaping_operation')}
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Text.DOC
This document contains the text-related topics for Simply3D help.



Creating and Modifying 3D Text
{button Tell me how...,PI(`',`HT_Creating_3D_Text')}

You create and modify Simply3D text by using the Text tool. You enter your text, and Simply3D makes the text 
three-dimensional by extruding it (giving it depth). You can then manipulate and animate the text object in the 
same ways as any 3D object. Here are examples of some characteristics you can control.

The shape of the text is affected by the 
extrusion, or depth. 

Extruded text

You can apply one of several bevel styles to
the edges of the text, and you can set the 
depth of the bevel.

Beveled text

After creating the text, you can use the 
reshaping tools to reshape it.

Reshaped text

{button Related Topics,PI(`',`RT_Creating_3D_Text')}



To create 3D text 
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To create 3D text

1 In the Toolbox, click the Text button . The Text tool opens.

2 Click the arrow  to display the font list, and then click the name of font you want to use.
3 Click in the blank area. A text cursor appears.
4 Type the text you want, click the Bold button  and the Italic 

 button, as desired, and then click Next to display the next window.
5 Click the bevel style you want, and click Next.
6 Click the text path you want, and click next.
7 Click the material you want to apply to the text, and click Next.
8 Click the animation you want (if any), and click Finish.
Tip
· You don’t have to go through all of the pages. You can click the Finish button anytime you are satisfied with 

the settings.
· If you want to manipulate the letters separately after creating a text object, right-click the object in the Scene

Explorer, and click Separate Letters.

{button Related Topics,PI(`',`RT_To_create_3D_text_with_the_Text_tool')}
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To modify 3D text
1 In the Scene Explorer, click the text object to select it.
2 On the Tools menu, click the Text button. The Text tool opens with a text cursor on the text.

3 If necessary, edit the text. If you want to change the font, click the arrow , and then click the name of font 
you want to use.

4 Click Next. If necessary, click a new bevel style.
5 Click Next. If necessary, click a new the material for the text.
6 Click Next. If necessary, click a new animation, and then click Finish.
Tips
· You don’t have to go through all of the pages. You can click the Finish button anytime you are satisfied with 

the settings.

{button Related Topics,PI(`',`RT_To_modify_3D_text_with_the_Text_tool')}
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This document contains the view-related topics for Simply3D help.



Setting Object-Previewing Options
{button Tell me how...,PI(`',`HT_Setting_Object_Previewing_Options')}

To provide a fast response as you manipulate objects, Simply3D shows objects as wireframes, bounding boxes, or
solid, gray-shaded objects until you render the scene.

Wireframe Bounding Box Shaded

Wireframe Shows a skeletal view of the object. You see only the outlines of the polygons that form the 
shape.

Bounding Box Represents the object as the outline of a box as you move, size, or rotate it. This is faster than
wireframe, but does not show any detail until you finish dragging. When you release the 
mouse button, you see the object as a wireframe.

Shaded Shows the object as solid, with shading. Although this is the slowest of the previewing options,
it is faster than manipulating a fully rendered object.

{button Related Topics,PI(`',`RT_Setting_Object_Previewing_Options')}



To preview objects as solid shapes 
To preview objects as wireframes 
To preview objects as bounding boxes 



Selecting Points of View 



To preview objects as solid shapes

On the Standard toolbar, click the Solid Shaded button 
.

{button Related Topics,PI(`',`RT_To_preview_objects_as_solid_shapes')}
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To preview objects as wireframes

1 On the Standard toolbar, click the Wireframe button .

2 If the Bounding Box button  is selected, click to deselect it.

{button Related Topics,PI(`',`RT_To_preview_objects_as_wireframes')}
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To preview objects as bounding boxes

On the Standard toolbar, click the Wireframe button 
, and then click the Bounding Box button 
.

{button Related Topics,PI(`',`RT_To_preview_objects_as_bounding_boxes')}
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To zoom in and out

 
1 If you are using the Camera view, click one of the other view buttons (Top , Side 

, Front 
, or Four Up 
) on the View toolbar. (You cannot use zoom tools in the Camera view.)

2 On the Standard toolbar, click either the Zoom In  or the Zoom Out button 
.

3 In the Top, Side, or Front view, click to zoom in or out. To reverse the effect of either button, click while 
holding down the CTRL key.

4 To stop using the Zoom In/Out tool, click any other tool.

{button Related Topics,PI(`',`RT_To_zoom_in_and_out')}



To adjust the zoom to show all objects 
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To adjust the zoom to show all objects

 
1 If you are using the Camera view, click one of the other view buttons (Top , Side 

, Front 
, or Four Up 
) on the View toolbar. (You cannot use zoom tools in the Camera view.)

2 On the Standard toolbar, click the Smart Zoom button . All views are set to a zoom setting that shows the 
camera and all objects.

Tip
· The Smart Zoom button is a one-time adjustment. To adjust the zoom automatically as you move the camera 

and objects in the scene, use the Autozoom  button.

{button Related Topics,PI(`',`RT_To_adjust_the_zoom_to_show_all_objects')}
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To adjust the zoom automatically

 
1 If you are using the Camera view, click one of the other view buttons (Top , Side 

, Front 
, or Four Up 
) on the View toolbar. (You cannot use zoom tools in the Camera view.)

2 On the Standard toolbar, click the Autozoom button . As you move items around in the scene, the zoom 
setting is automatically adjusted in and out to show the camera and all objects.

3 To return to manual zoom adjustment, click the Autozoom button again.
Tip
· If you only want a one-time zoom adjustment that shows the camera and all objects, use the Smart Zoom 

tool  instead of Autozoom.

{button Related Topics,PI(`',`RT_To_make_Simply_3D_adjust_the_zoom_automatically')}



To zoom in and out 
To adjust the zoom to show all objects 

Selecting Points of View 



To show or hide the Animation Editor

On the View menu, click Animation Editor.

{button Related Topics,PI(`',`RT_To_show_or_hide_the_Animation_Editor')}
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Selecting Points of View
{button Tell me how...,PI(`',`HT_Selecting_Points_of_View')}

The Camera view is the view that is rendered. From this view, however, it is not always possible to determine an 
object’s position relative to other objects in the scene. Using other views such as Top, Side, and Front allows you 
to see and adjust relationships between objects.

 

Camera view (rendered) Top view

Side view Front view

The Top, Side, and Front views lack perspective and show movement only along two axes. Changes along the 
hidden axis (the axis in which objects would move toward or away from you) are not visible. For example, in the 
Side view, movement on the X axis is not visible.

{button Related Topics,PI(`',`RT_Using_Points_of_View')}
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To view a scene through the camera

 
On the View toolbar, click the Camera View button 

.

{button Related Topics,PI(`',`RT_To_view_a_scene_through_the_camera')}
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To view a scene from the Top, Side, or Front view

 
On the View toolbar, click the Top View 

, Side View 
, or Front View 
 button.

{button Related Topics,PI(`',`RT_To_view_a_scene_from_the_Top_Side_or_Front_view')}
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To view a scene using the Four Up view

 
On the View toolbar, click the Four-Up View button 

.
Tip
· When you click or drag in four-up view, Simply3D displays a yellow border around the active view. This is 

particularly helpful for previewing animations, because only the active view shows the animation.

{button Related Topics,PI(`',`RT_To_view_a_scene_using_the_Four_Up_view')}
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This document contains the context-sensitive topics and popups for all Simply3D 3 wizard pages.



Project wizard start page

The Project wizard gives you a step-by-step method of quickly building a complete 3D scene. When you have 
finished building the scene, the wizard helps you either print the scene or save it in a format that lets you use it 
with other programs.
Tips
· You can start with a template, which is a complete scene that you can modify, or you can start by adding 

objects to an empty scene.
· You can choose a background, create custom 3D text, add catalog objects, and create 3D shapes extruded 

from 2D drawings.
· You can animate any object in your scene by selecting from a list of catalog animations.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Start with template page

This page of the Project wizard lets you start with a template, which is a complete scene that you can modify.
Tips
· After choosing a template from the displayed list, you can change the background, create custom 3D text, 

add catalog objects, and create 3D shapes extruded from 2D drawings.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Project wizard continue page

This wizard page displays options for continuing to build or modify your scene. If you have finished, click Finish at
the bottom of the page.
Tips
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Replace object page

Follow the steps on this wizard page to replace an object in your scene. You can replace the object with another 
object, new 3D text, or a 3D shape extruded from a 2D drawing.
Tips
· If the list under Step 1 contains more than one object, click the object that you want to change before 

clicking a replacement type under Step 2.
· The replacement object is added at the center of the scene. After replacing, however, you can position 

objects so they don't overlap.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Add object page

Click one of the buttons on this wizard page to add a new object to your scene. You can add a 3D object, create 
new 3D text, or choose a 3D shape extruded from a 2D drawing.
Tips
· All added objects are added at the center of the scene. After adding an object, however, you can position 

objects so they don't overlap.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Extrude 2D shape

This tool lets you create a 3D shape by extruding, or stretching, a 2D shape along the Z axis.
Tips
· You can choose a starting 2D shape by clicking a shape in the 2D Shapes list, importing a 2D drawing file, or 

pasting a 2D drawing from the Clipboard.

· To see a list of supported 2D file formats, click the Import button. On the Open dialog box, click the arrow .
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the tool, click one of the wizard navigation buttons at the bottom of the window.



Bevel and Extrusion page

Follow the steps on this wizard page to chisel the edges of 3D text letters and objects made from extruded 2D 
shapes. You select a bevel type and set the depth of the bevel and the depth of extrusion.
Tip
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Material selection page

Follow the steps on this wizard page to cover objects in your scene with static or animated materials. Materials 
can come from the Simply3D catalog, a bitmap image on the Clipboard, or a bitmap or animation file.
Tips
· If you select an object with multiple materials, the wizard displays a list of the materials used by the object. 

Click the specific material that you want to replace.
· If you select a 3D text object, a button appears that lets you apply different material to each letter of the 

text. The wizard displays a list of the letters. Click the picture of the letter that you want to change, and click 
the material that you want to apply.

· For 3D text and extruded 2D objects, a button appears that lets you apply different materials to the front, 
side, and bevel edges. When you click the button, the wizard displays a list of three edge choices. Click the 
picture of the edge you want to change, and click the material that you want to apply to that edge.

· Some of the catalog materials are already animated for you. To see an animated sample of an animated 
material, pause the pointer on the material.

· Use the camera preview area to see you how your results will look. It also has tools to let you move the 
camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



3D text entry page

Follow the steps on this wizard page to create or edit a line of 3D text. 
Tips
· The text box must contain at least one letter of text before you can proceed to the next page of the wizard. 

You can cut, copy, or paste Clipboard text in the text box.

· The fonts listed when you click the arrow  are those available for the currently active printer. Each name in
the list is displayed in a sample of its font.

· The box and slider for setting the letter spacing are disabled until you enter at least two letters of text.
· All added objects are added at the center of the scene. After adding an object, however, you can position 

objects so they don't overlap.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Animation selection page

Follow the steps on this wizard page to apply a catalog animation to an object in your scene. For 3D text object, 
you can choose to apply the animation to the text as a single object or separately to each letter.
Tips
· When you click a 3D text object as the object to animate, a button appears that lets you can choose to apply 

the animation to the text as a single object or separately to each letter.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Background selection page

This wizard page lets you select a background for your scene.
Tips
· Simply 3D automatically stretches or compresses the background image so that it exactly fills the camera 

view of the scene.
· The list of catalog backgrounds is identical to the list of materials that you choose from when assigning 

materials to objects.
· Some of the catalog materials are animated. To see an animated sample of an animated material, pause the 

pointer on the material.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Remove objects page

This wizard page displays a list of the objects in your scene and lets you remove one or more of them. 
Tips
· To remove an object, click the picture of the object in the list, and click Remove Object.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Position objects page

Follow the steps on this wizard page to move, align, and rotate objects in your scene.
Tips
· The Align button is enabled only if the scene contains two or more objects. 
· When you click the Align button, the wizard displays a second list so you can choose a target object for the 

alignment. The object that moves when you click one of the alignment pictures is the object that you 
selected in Step 1.

· Use the camera preview area to see you how your results will look. It also has tools to let you move the 
camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Effects and text-along-a-path page

Follow the steps on this wizard page to deform objects in your scene or to align 3D text to one of several paths.
Tips
· The list under Step 2 changes depending on the type of object you select in Step 1. For 3D text, the list 

shows several text paths along which you can align 3D text. For all other objects, the list shows deformation 
options.

· For 3D text, the Follow option rotates each text letter to make it follow the path instead of remaining upright.
· Use the camera preview area to see you how your results will look. It also has tools to let you move the 

camera, render the scene, and play animations contained in the scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Finish page

This page of the Project wizard lets you finish a scene that you have built. You can choose to make it a Simply 3D
scene, print it, or save it in a format that lets you use it with other programs.
Tips
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.
· If you choose to save the scene for display on Web pages or for use with other programs, the wizard gives 

you more options. Each set of options takes you through a decision process that leads to the most suitable 
file format.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Static Internet output page

This page of the Project wizard lets you choose one of three file formats that are commonly used for static 
(nonanimated) Internet images: JPEG, CompuServe GIF, or VRML files.
Tips
· To view your static scene on a Web page, users must have a Web browser that supports the format you 

choose. 
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Animated Internet output page

This page of the Project wizard lets you choose either Animated GIF or VRML as the Internet file format for your 
animated scene.
Tips
· To view your animated scene on a Web page, users will need a Web browser that supports the format you 

choose. 
· Animated GIF is widely supported, but large scene dimensions will produce large file sizes that load slowly 

over modem connections. 
· VRML files (.wrl files) are relatively small, regardless of the scene dimensions. However, VRML is a more 

recently adopted format, and some browsers might not support it without additional plug-in software.
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Desktop image output page

This page of the Project wizard lets you choose either BMP, Targa, or TIF as the image file format for your static 
(nonanimated) scene.
Tip
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Desktop animation output page

This page of the Project wizard lets you choose either a file format that you can insert into a presentation 
program or a format that you can run independently as a video file.
Tip
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Animated desktop presentations page

This page of the Project wizard lets you choose either a file format that you can insert into a presentation 
program or a format that you can use independently for desktop video.
Tips
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.
· Saving an animated scene can be time consuming. Plan your use of the computer before committing it to 

saving a long animation or an animation of a complex scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Desktop video output page

This page of the Project wizard lets you save your animated scene in one of three video file formats: AVI, FLC, 
and Sequential Targa.
Tips
· Regardless of which option you choose, remember to save your finished scene after you exit the Project 

wizard. You must save the scene as an S3D file if you want to edit it later.
· Saving an animated scene can be time consuming. Plan your use of the computer before committing it to 

saving a long animation or an animation of a complex scene.

When you have finished with the page, click one of the wizard navigation buttons at the bottom of the page.



Generic popup items that are common to many wizard pages



Note
· If you are building a scene with the Project Wizard, the camera view that you set here is carried forward into 

the finished scene. Otherwise, this view is only temporary.



These buttons let you navigate through the wizard. Only the applicable buttons for the current wizard page are 
displayed. You cannot use a button while it is dimmed (disabled).
Cancel Removes all items you have built in the wizard, closes the wizard, and returns you to the 

project window.
Start Over Removes all items you have built in the wizard, and restarts the wizard.
Back Takes you to the previous page of the wizard.
Next Proceeds to the next page of the wizard, where you continue to add objects or changes to your 

scene.
Finish Closes the wizard or tool. If you are using the Project wizard, you will see options for how to use

the scene you have created. If you are using the Text tool, you are returned to your project with
the new text in the scene.

Displays tips for using the current wizard page.





Videos.doc
This file contains the topics that play video clips for Simply3D help.



Show me: Adding an Animation
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,ADDANIM.AVI} 



Show me: Adding an Object from the Catalog
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,ADDOBJFROMCAT.AVI} 



Show me: Aiming the Camera
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,AIMCAMERA.AVI} 



Show me: Using Points of View and Zoom Tools
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,POINTSOFVIEW.AVI} 



Show me: Scaling a Material
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,SCALEMATERIAL.AVI} 



Show me: Moving a Light
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,MOVELIGHT.AVI} 



Show me: Selecting an Object
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,PICKONEOBJ.AVI} 



Show me: Moving an Object by Dragging
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,MOVEOBJ.AVI} 



Show me: Rotating an Object by Dragging
To stop the video and close this window, press the ESC key.

{mci PLAY NOPLAYBAR,ROTATEOBJ.AVI} 



Show me: Setting the Lens Angle
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,SETLENS.AVI} 



Show me: Moving the Camera
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,MOVECAMERA.AVI} 



Show me: Rotating the Camera
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,ROTATECAMERA.AVI} 



Show me: Scaling Objects by Dragging
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,SCALEOBJ.AVI} 



Show me: Previewing Animations
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,PREVIEWANIM.AVI} 



Show me: Rendering Scenes
To close this window, press the ESC key.

{mci PLAY NOPLAYBAR,RENDER.AVI} 




